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Special Notices

• The software and this owner’s manual are the exclu-
sive copyrights of Yamaha Corporation.

• Copying of the software or reproduction of this 
manual in whole or in part by any means is expressly 
forbidden without the written consent of the manu-
facturer.

• Copying of the commercially available music 
sequence data and/or digital audio files is strictly 
prohibited except for your personal use.

• Yamaha makes no representations or warranties 
with regard to the use of the software and documen-
tation and cannot be held responsible for the results 
of the use of this manual and the software.

• The screen displays as illustrated in this owner’s 
manual are for instructional purposes, and may 
appear somewhat different from the screens which 
appear on your computer.

• For information on modification of system software, 
certain functions, or specifications due to version 
update of the application, please visit the following 
website:
http://www.yamahaproaudio.com/

• Windows is a registered trademark of Microsoft® 
Corporation in the U.S. and other countries.

• Apple, Mac and Macintosh are trademarks of Apple 
Inc., registered in the U.S. and other countries.

• The company names and product names in this 
Owner’s Manual are the trademarks or registered 
trademarks of their respective companies.

❏Yamaha Pro Audio Global Site
http://www.yamahaproaudio.com/
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Description of menus and buttons
In the event that menu and button names on a Windows 
system are different from those on a Mac, this manual uses 
the Windows menu and button names followed by the Mac 
menu and button names in parentheses.

http://www.yamahaproaudio.com/
http://www.yamahaproaudio.com/
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Overview of QL Editor

QL Editor enables you to remotely control a Yamaha QL mixing console (such as QL5, or QL1; hereinafter collectively 
called “QL” in this document). QL Editor also enables you to save the parameter settings on your computer. 

Configuring QL Editor

❏System Setup
To open the System Setup dialog box, choose [System Setup] from the [File] menu. 

1Network
Specify the IP Address of your QL console to com-
municate.

2Model Select
Select the model of your QL (QL5/QL1) when QL 
Editor is not synchronized with the QL console. If 
QL Editor is synchronized with the QL console, the 
model will automatically be selected and other 
model options will be grayed out.

3Channel Select/Sends On Fader
This checkbox enables you to specify whether or 
not the QL console and QL Editor are linked to each 
other for the following operations:
• Selecting channels
• Switching between normal mode and SENDS 

ON FADER mode
• Switching between MIX and MATIRX in 

SENDS ON FADER mode
• Selecting [CUE] buttons
If you do not check the box, the QL console and QL Editor will operate independently.

If the box is not checked, the [CUE] button will be hidden in each window.

4 Synchronization
This allows synchronization to be done automatically when a QL Editor file is loaded. This function is enabled by 
default.

5Window Control From Console
This option determines whether or not using the USER DEFINED KEYS on the console enables you to remotely open 
and close the QL Editor windows.

6 Level Meter
This option specifies whether the level meter functionality will be enabled. By disabling the meter function you can 
reduce the processing load caused by screen drawing and communication.

7Confirmation
These check boxes specify whether a confirmation dialog box will appear when you store (Store Confirmation), recall 
(Recall Confirmation), patch (Patch Confirmation), or make a patch change that would modify an existing patch (Steal 
Patch Confirmation).

8Administrator Password
Enter the Administrator password that was specified on the QL console. If this password is not entered correctly, it will 
not be possible to synchronize from QL Editor to the QL console.
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9 Set Default
Press this button to use the settings (except for the IP Address in the Network section) currently specified in the System 
Setup dialog box as the default settings. The next time when you start up QL Editor, it will use these settings.

❏Mixer Setup
To open the Mixer Setup dialog box, choose [Mixer Setup] from the [File] menu.

1Mix Bus Setup
Here you can make settings relating to the MIX buses.
Signal Type: Choose either MONOx2 or STEREO for 
each two adjacent odd-numbered/even-numbered MIX 
buses.
Bus Type/Send Point: Choose either VARI (PRE 
FADER) or VARI (PRE EQ) or FIXED for each two adjacent 
odd-numbered/even-numbered MIX buses.
Pan Link: The PAN setting for signals sent to stereo MIX 
buses will link to the PAN setting for the STEREO bus. This 
parameter is valid only if the Signal Type is set to STEREO 
and the Bus Type is set to VARI.

2Matrix Bus Setup
Here you can make settings relating to the MATRIX buses.
Signal Type: Choose either MONOx2 or STEREO for 
each two adjacent odd-numbered/even-numbered MATRIX 
buses.
Send Point for Input Channels: Choose either PRE 
FADER or PRE EQ for each two adjacent odd-numbered/
even-numbered MATRIX buses.
Pan Link: The PAN setting for signals sent to stereo 
MATRIX buses will link to the PAN setting for the STEREO 
bus. This parameter is valid only if the Signal Type is set to 
STEREO.

1
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❏Creating a user key
To open the Create User Key dialog box, choose [Create User Key] from the [File] menu.
This creates a user key (with “.CLU” file name extension) that can be read from a USB flash drive by the QL console to 
automatically set user-specific parameters.

1User Name
Specify the name of the user. You can enter up to eight single-byte alphanumeric characters. 

2Comment
Enter a comment for each user. You can enter up to thirty-two single-byte alphanumeric characters.

3Password
Enter a password that will be used when this user key is read by the QL console. You can enter up to eight single-byte 
alphanumeric characters. Uppercase and lowercase are distinguished.

4Re-Enter Password
Enter the password once again as a safeguard against mistaken entry. 

5POWER USER
Specify whether this user is a power user. Power users can use the QL console to create or edit a user authentication key 
with a specified user level.

6Administrator Password
Enter the Administrator password that was specified on the QL console. This is not required if no Administrator pass-
word has been specified on the QL console, but if this password is incorrect you will be asked to enter it when the user 
key is read.

7ACCESS PERMISSION
In this area, specify the parameters that this user will be allowed to operate.
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8CH OPERATION
INPUT, ST IN, MIX, MATRIX, ST/MONO, DCA: Select the channels whose parameters will be operable.
HA: Change the operating privileges for the head amp gain (analog gain) and phantom power of the selected chan-
nels.
PROCESSING: Change the operating privileges for overall signal processing parameters (except for fader and 
[ON] button) of the selected channel. For the specific parameters included in PROCESSING, refer to the QL’s man-
ual.
FADER/ON: Change the operating privileges for the pan/balance, fader, channel on, send on/off, and send level of 
the selected channels.
Set All: Turn on HA, PROCESSING, and FADER/ON for all channels.
Clear All: Turn off HA, PROCESSING, and FADER/ON for all channels.
Set by One Click: If this button is on, pressing the channel select button repeatedly will set HA, PROCESSING, 
and FADER/ON to On or Off simultaneously.

9 SCENE LIST
STORE/SORT: Change the operating privileges for scene store and sort operations.
RECALL: Change the operating privileges for scene recall operations.

0 LIBRARY LIST
STORE/CLEAR: Change the operating privileges for library store and clear operations.
RECALL: Change the operating privileges for library recall operations.

A FILE LOAD
USER SETUP: Change the operating privileges for loading user-defined keys and preferences when loading a file.
SYSTEM SETUP MONITOR SETUP: Change the operating privileges for loading system setup and monitor 
setup settings when loading a file.
CURRENT SCENE: Change the operating privileges for loading the current scene when loading a file.
SCENE LIST: Change the operating privileges for loading the scene list when loading a file.
LIBRARY LIST: Change the operating privileges for loading the library list when loading a file.

BCURRENT SCENE
INPUT PATCH: Change the operating privileges for input patch operations.
INPUT NAME: Change the privileges for editing the input names.
OUTPUT PATCH: Change the operating privileges for output patching.
OUTPUT NAME: Change the privileges for editing the output names.
BUS SETUP: Change the operating privileges for buses.
GEQ RACK: Change the operating privileges for GEQ (Graphic Equalizer) rack operations.
EFFECT RACK: Change the operating privileges for EFFECT rack operations. 
PREMIUM RACK: Change the operating privileges for PREMIUM rack operations. 
MUTE GROUP ASSIGN: Change the privileges for assigning mute groups.
MUTE GROUP MASTER: Change the operating privileges for enabling/disabling mute groups.

CMONITOR SETUP
OSCILLATOR: Change the operating privileges for oscillator settings.
TALKBACK: Change the operating privileges for talkback settings.

D SYSTEM SETUP
MIXER SETUP: Change the privileges for making mixer setup settings.
OUTPORT SETUP: Change the privileges for making outport setup settings.
MIDI/GPI: Change the privileges for making MIDI and GPI settings.

ECreate
Creates the user key.

FCancel
Closes the dialog box.
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Handling Files

The following table describes how to handle files.

Files dedicated for QL Editor have a filename extension of “.QLE”. Files in which only the CL/QL console data is saved (file-
name extension “.CLF”) can also be handled, allowing you to use a USB flash drive to exchange data with the QL console.

Undo/Redo Function

In QL Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the latest operation (Redo). If 
you perform an Undo operation twice in a row, you can cancel the two most-recent operations. If you perform an Undo 
operation three times in a row, you can cancel the three most-recent operations. In this way, you can cancel multiple recent 
operations. 
The following table describes how to use the Undo/Redo function.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo any 
previous operation:
• Operations on the QL console
• Synchronizing with the QL console

You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing or moving the windows
There are certain other operations that cannot be undone, depending on the function. 

For library or scene operations, Undo/Redo applies only to the single most recent operation. You cannot 
undo any operations prior to this. Undo/Redo in these windows is available only using the [UNDO] but-
ton within the respective window. Even if you perform a scene recall from the Master window, you cannot 
use a shortcut or menu operation to undo the recall.

Creating a new file Choose [New] from the [File] menu.

Opening a previously saved file Choose [Open...] from the [File] menu.

Saving the current file Choose [Save] from the [File] menu.

Saving the current file with a new name Choose [Save As...] from the [File] menu.

Quitting the QL Editor Choose [Exit] from the [File] menu.

Undo Choose [Undo] from the [Edit] menu.

Redo Choose [Redo] from the [Edit] menu.

NOTE

NOTE
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Window operations

You can select and open each window from the [Windows] menu.

You can choose Tile or Cascade to arrange the windows within the editor.

In the Library window or Scene window, click the tabs located at the top of the window to switch between pages.

● Cascade● Tile
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Synchronizing QL Editor

When QL Editor starts up, the parameter settings on the console and the parameter settings in QL Editor may be different. 
Therefore, you must first match the parameter settings on the console with those in QL Editor. This operation is called 
“synchronization.” Follow the steps below to synchronize QL Editor.
1 Select [Synchronization], then [Re-synchronize].

The following window opens.
If QL Editor is in the offline status the 
[Re-synchronize] function is not available.

2 Select whether you want to transfer your settings to 
QL Editor, or vice versa.
Console -> PC: Transfers the current parameter settings of 
your console to the QL Editor.
PC -> Console: Transfers the current parameter settings in QL Editor to your console. 
At this time, the All Libraries option determines whether or not Library data is synchronized. 
If you select the [Dante Setup and I/O Device] check box, Dante settings will also be synchronized. Clear this check box 
if you want to preserve the Dante settings of the QL console when using PC -> Console.

The Dante settings of the QL console will be copied to QL Editor if you clear this check box and select 
PC -> Console, or if you select Console -> PC.

3 Click [OK].

Do not operate the console while synchronization is in progress.

Offline Edit Function

If you do not want to synchronize your console with QL Editor, select [Offline Edit] from the [Synchronization] menu. To 
apply your off-line edits to your console, select [Re-Synchronize] from the [Synchronization] with the PC -> Console 
option to synchronize the console with QL Editor.
The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the Master window.

Some effect parameters in the console change their displayed values depending on the sampling fre-
quency. If you switch QL Editor from OFFLINE to ONLINE, displayed parameter values may change 
because QL Editor loads the sampling frequency from the console and updates the display.

Other Functions

❏Resetting to the default value (Ctrl( )+click)
Move the cursor to a control or a parameter value, then hold down the <Ctrl>(< >) key and click the mouse button to 
reset the value to the default (e.g., to reset a pan setting to Center).
However, the channel faders and the send knobs and bar graphs can be set to –∞ regardless of the default value.

❏Ctrl( )+Shift+Click
Move the mouse cursor to a channel fader or to a send knob or bar graph, and click while holding down the 
<Ctrl>(< >) key and <Shift> key to set the nominal value regardless of the default value.

NOTE

NOTE

NOTE
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In the Master window you can synchronize to the QL itself, recall scenes, and display the Overview window. To open this 
window, choose [Master] from the [Windows] menu.

❏CHANNEL SELECT
This indicates the number and name of the channel to which your operations will apply. To 
switch channels, you can either click the [SELECT] button and choose from the list that 
appears, or you can click the plus/minus (+/–) channel select buttons on the left or right side 
of the icon. You can also use the channel name text box to edit the name.
If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is selected, 
this parameter is linked with the [SEL] buttons on the QL console panel.
You can right-click (<control> key + click) the icon to select a different one. You can also left-
click the icon to select a channel color.

❏SENDS ON FADER
This button indicates whether normal mode or SENDS ON FADER mode is engaged. Click 
the button to switch modes. When SENDS ON FADER mode is engaged, the Sends On Fader 
window appears. (➥ p.93)
If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is selected, 
this parameter will be linked with the SENDS ON FADER mode setting on the QL console.

Master window
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❏SYNC
This indicates the status of connection and synchronization between QL Editor and the QL.

1 [ONLINE]/[OFFLINE] button
The ONLINE/OFFLINE status will alternate each time you click this button.
This has the same function as [Synchronization] menu ➔[Offline Edit]. (➥ p.8)

This indicator is shown when QL Editor is correctly connected to 
the QL itself. In this state, the parameters of QL Editor and the QL 
itself are linked.
This indicator is shown when QL Editor and the QL itself are not 
connected, or when there is a problem with the connection, or when 
Offline Edit is selected. In this state, the parameters of QL Editor 
and the QL itself are not linked.

2 [RE-SYNC] button
Clicking this button opens the Synchronization dialog box.
This has the same function as [Synchronization] menu ➔ [Re-Synchronize]. (➥ p.8)

If QL Editor is in the offline status the [Re-synchronize] function is not avail-
able.

❏SCENE MEMORY
Here you can view the currently-recalled scene, and recall or store scenes.

1 Scene number display
Indicates the number of the scene that is selected for store or recall.

2Protect indicator
The lock icon is displayed for scenes that are protected. You will be unable to overwrite or 
modify the titles of such scenes. For read-only scenes, “R” appears instead.

3Edit indicator
The edit indicator will light when you edit the parameters after recalling a scene.

4 [STORE] button
This button stores the current scene into the number shown by the scene number display 
(1).

5 [INC]/[DEC] buttons
These buttons increment or decrement the number shown in the scene number display 
(1). The scene number display (1) will blink until you actually store or recall, and while 
blinking will not match the scene number indicated on the QL.

6 [RECALL] button
This button recalls the scene of the number shown in the scene number display (1).

1 2

NOTE
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❏Bank Select Keys
Opens the corresponding window in the Overview window.

These are not linked with the bank select key section on the panel of the QL itself.

INPUT

1 [1-16] button
Opens the INPUT CH 1–16 window.

2 [17-32] button
Opens the INPUT CH 17–32 window.

3 [33-48] button (only QL5)
Opens the INPUT CH 33–48 window.

4 [49-64] button (only QL5)
Opens the INPUT CH 49–64 window.

5 [ST IN] button
Opens the ST IN window.

6 [DCA] button
Opens the DCA (Digital-Controlled Amplifier) window.

OUTPUT

7 [1-16] button
Opens the MIX CH 1–16 window.

8 [MTRX] button
Opens the MATRIX window.

9 [ST] button
Opens the STEREO/MONO window.

CUSTOM FADER

0B1 [1-16] button
Opens the CUSTOM FADER bank B1 1–16 window.

AB1 [17-32] button (only QL5)
Opens the CUSTOM FADER bank B1 17–32 window.

BB2 [1-16] button
Opens the CUSTOM FADER bank B2 1–16 window.

CB2 [17-32] button (only QL5)
Opens the CUSTOM FADER bank B2 17–32 window.

DB3 [1-16] button
Opens the CUSTOM FADER bank B3 1–16 window.

EB3 [17-32] button (only QL5)
Opens the CUSTOM FADER bank B3 17–32 window.

FB4 [1-16] button
Opens the CUSTOM FADER bank B4 1–16 window.

GB4 [17-32] button (only QL5)
Opens the CUSTOM FADER bank B4 17–32 window.

NOTE
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INPUT CH window

This window displays the mix parameters of INPUT CH 1–16, 17–32, 33–48 (only QL5), 49–64 (only QL5.) The parame-
ters shown in the window can be selected from the [View] menu or the menu that appears when you right-click (<control> 
key + click) in the window.
You can access this window in the following ways.

• From the [Windows] menu, choose [Overview] and select CH 1–16, 17–32, 33–48 (only QL5), or 49–64 (only QL5)
• Use the bank select keys in the Master window to turn on the [1-16] button/[17-32] button/[33-48] button (only QL5), 

or [49-64] button (only QL5)

1 Input patch
Click here to select the input source that will be assigned to the INPUT CH, from the fol-
lowing choices.

2HA (HA analog gain)
Drag the knob in the screen to adjust the analog gain of the internal head amp or of the 
external head amp patched to the INPUT CH.

348V (Phantom power)
Switches on/off the phantom power (+48V) of the internal head amp or of the external head 
amp patched to the INPUT CH.

NONE No assignment

DANTE 1–32, DANTE 33–64 (only QL5)
DANTE INPUT 1–32, DANTE INPUT 33–64 
(only QL5)

INPUT 1–16, INPUT 17–32, (only QL5) INPUT jacks 1–16, INPUT jacks 17–32 (only QL5)

PB OUT L, PB OUT R L/R outputs of PLAYBACK

SLOT1-1, SLOT1-2...SLOT2-15, 
SLOT2-16

Input channels of an I/O card installed in slots 1–2

FX1L(A), FX1R(B)...FX8L(A), FX8R(B) L/R outputs of EFFECT rack 1–8

PR1L(A), PR1R(B)...PR8L(A), PR8R(B) L/R outputs of PREMIUM rack 1–8

Overview window

1

2

3
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4Ø (Phase)
Inverts the phase polarity of the signal after AD conversion.

5Digital Gain
Drag the knob in the screen to adjust the input gain of each input channel.

6HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit the 
cutoff frequency.

7 INSERT
Enables/disables the insert-in.

8D. OUT (Direct out)
Enables/disables the direct output.

9 EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approximate 
response of the EQ. Double-click within the graph to open the Selected Channel window of 
the corresponding channel. To open the Selected Channel window as an additional view, 
hold down the <Ctrl>(< >) key of your computer keyboard and double-click the graph.

0DYNA1/DYNA2 (Dynamics 1/Dynamics 2)
Turns the two dynamics processors on/off.
If Gate is assigned (Dynamics 1 only), the status of the gate is shown immediately below the 
button.

If something other than Gate is assigned, a GR meter is shown immediately below the but-
ton, and the amount of gain reduction is shown while this is on.
The type for each dynamics processor can be selected in the Selected Channel window. 
Double-click anywhere other than the DYNA1 or DYNA2 button to open the Selected 
Channel window of the corresponding channel. To open the Selected Channel window as 
an additional view, hold down the <Ctrl>(< >) key of your computer keyboard and dou-
ble-click anywhere other than the DYNA1 or DYNA2 button.

ADELAY
Turns the input delay processors on/off. The current delay value is shown in the numerical 
box located immediately below the button. You can also edit the delay value in this text box.

BMIX/MATRIX (MIX/MATRIX SEND)
Switches between the send indications to MIX buses 1–16 and to MATRIX buses 1–8.
The bar graphs located immediately below the button show the send level of the signals sent 
from the INPUT CH to VARI type MIX/MATRIX buses. You can also drag the bar graph to 
left or right to set the send level. While you drag the bar graph, the send level is shown in the 
numerical display area for PAN/TO STEREO MONO (C).
You can set the minimum value (–∞ dB) by holding down the <Ctrl>(< >) key of your 
computer keyboard and clicking the bar graph, or set the nominal value (0.00 dB) by hold-
ing down the <Ctrl>(< >) key and <Shift> key and clicking the bar graph.
The bar graph display will change according to the send position (pre/post) and on/off sta-
tus of the signal sent from the INPUT CH to the MIX/MATRIX buses.
To switch a send on/off, click the channel number located at the left of the bar graph.

For FIXED-type MIX buses, the bar graph is fixed at nominal level (0 dB), 
and only the on/off status is shown.

In SENDS ON FADER mode, this button enables you to adjust the send 
level using the fader.

Gate status 
indication

On/off status On On On Off

Open/closed 
status

Closed Open Open —

Remarks
Gain reduction amount 
is 30 dB or more

Gain reduction 
amount is 0–30 dB

Gain reduction 
amount is 0 dB

—

4

5

6

7

8

9

0

B

A

Pre/on (green)

Pre/off (green)

Post/on (orange)

Post/off (orange)

NOTE

NOTE
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CPAN/ST/M(C)
The PAN knob adjusts the panning of the signal that is sent from the INPUT CH to the 
STEREO bus L/R channels (or the L/C/R channels.) You can set this to the center value by 
holding down the <Ctrl>(< >) key of your computer keyboard and clicking this knob.
The [ST] button is an on/off switch for the signal that is sent from the INPUT CH to the 
STEREO bus.
The [M(C)] button is an on/off switch for the signal that is sent from the INPUT CH to the 
MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will appear 
instead of the [ST] button and [M(C)] button, and the [LCR] button will be an on/off switch 
for the signal that is sent from the INPUT CH to the LCR bus.

D SEL (Channel selection)
Selects the INPUT CH for which you want to perform operations. 

ECUE
This button cue-monitors the signal of the INPUT CH. 

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

FON
Switches the INPUT CH or send on/off. 
The button is color-coded and indicates status as follows:

White: INPUT CH is on (normal mode.)
Black: INPUT CH/Send are off.
Other colors: Send is on (SENDS ON FADER mode.)

G Fader
Adjusts the input level of the INPUT CH, or the send level. 
The fader is color-coded and indicates status as follows:

White: You can adjust the input level of the INPUT CH (normal mode.)
Gray: INPUT CH is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)

The current fader value is shown in the numerical box located immediately below the fader.
You can set this to the minimum value (–∞ dB) by holding down the <Ctrl>(< >) key of your computer keyboard and 
clicking the fader knob, or set it to the nominal value (0.00 dB) by holding down the <Ctrl>(< >) key and <Shift> key 
and clicking the fader knob.
The numbers and alphabetical letters at the right of the fader indicate the DCA group and mute groups to which that 
channel belongs, and show the Recall Safe and Mute Safe status of the channel.

Click the indicator area to switch between 3 indicators.

HChannel number
This is the number of the INPUT CH. You can open the Selected Channel window for this channel by double-clicking 
this number. If you hold down the <Ctrl>(< >) key of your computer keyboard and double-click this, the Selected 
Channel window will open as an additional view.

IChannel name
This is a text box that displays the channel name. You can also edit the channel name in this text box.
You can right-click (<control> key + click) the text box to select a channel color.

C

D
E

F

G

H

I

NOTE

The numbers of DCA groups 
to which this channel belongs 
are shown in yellow.

The numbers of mute groups to 
which this channel belongs are 
shown in red when those groups are 
muted. If the dimmer levels for those 
groups are set in a non-default 
status, those are shown in orange.

If this channel is set to Recall 
Safe, the R character is 
shown in green.

If this channel is set to Mute Safe, 
the M character is shown in green.

This level meter is displayed 
at the same metering point 
with the input channel in 
Meter window setup (➥ p.72.)

Mute Group indicator Level MeterDCA Group indicator

NOTE
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ST IN window

In this window you can view and edit the mix parameters of ST IN channels 1–8. The parameters shown in the window can 
be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the window.

You can access this window in the following ways.
• From the [Windows] menu, choose [Overview] and then choose “ST IN”
• Use the bank select keys in the Master window to turn on the [ST IN] button

1 Input patch
Selects the input source that will be assigned to the ST IN channel. The input sources that 
can be assigned are the same as for an INPUT CH (➥ p.12.)

2HA (HA analog gain)
Drag the knob in the screen to adjust the analog gain of the internal head amp or of the 
external head amp patched to the ST IN channel.

348V (Phantom power)
Switches on/off the phantom power (+48V) of the internal head amp or of the external head 
amp patched to the ST IN channel.

4Ø (Phase)
Inverts the phase polarity of the signal after AD conversion.

5Digital Gain
Drag the knob in the screen to adjust the input gain to each ST IN channel.

6HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit the 
cutoff frequency.

7 EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked.) This is the same as the equalizer for 
INPUT CH (➥ p.13.)

7

6

5

2
1

34



QL Editor Owner’s Manual16

8DYNA1/DYNA2 (Dynamics 1/Dynamics 2)
These buttons switch the two dynamics processors on/off. This is the same as the 
dynamics 1/dynamics 2 for INPUT CH (➥ p.13.)

9DELAY
Turns the input delay processors on/off. The current delay value is shown in the numerical 
box located immediately below the button. You can also edit the delay value in this box.

0MIX/MATRIX (MIX/MATRIX SEND)
Switches between the send indications to MIX buses 1–16 or to MATRIX buses 1–8. This is 
the same as the mix/matrix send for INPUT CH (➥ p.13.)

APAN/BALANCE/ST/M(C)
Displays the PAN/BALANCE knobs for L/R channels. PAN/BALANCE is synchronized to 
the Pan/Balance of the “TO STEREO/MONO” section. The BALANCE knob adjusts the 
balance of the signal that is sent from the ST IN channel to the STEREO bus L/R channels 
(or the L/C/R channels.)The PAN knob adjusts the panning of the signal that is sent from 
the INPUT CH to the STEREO bus L/R channels. Other than the PAN/BALANCE knob, 
this is the same as PAN/TO STEREO MONO for an INPUT channel (➥ p.14.)

B SEL (Channel selection)
Selects the ST IN channel for which you want to perform operations. (L and R can be 
selected separately.) 

CCUE
This button cue-monitors the signal of the ST IN channel.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

DON
Switches the ST IN channel on/off.
The button is color-coded and indicates status as follows:

White: ST IN channel is on (normal mode.)
Black: ST IN channel/Send are off.
Other colors: Send is on (SENDS ON FADER mode.)

E Fader
Adjusts the input level of the ST IN channel. 
The fader is color-coded and indicates status as follows:

White: You can adjust the input level of the ST IN channel (normal mode.)
Gray: ST IN channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)

The current fader value is shown in the numerical box located immediately below the fader. 
This is the same as the fader for INPUT CH (➥ p.14.)

Click the indicator area at the right side of the fader to switch between 3 
indicators (mute group indicator, DCA group indicator, level meter).

FChannel number
This is the number of the ST IN channel. You can double-click this number to open the 
Selected Channel window for this channel. If you hold down the <Ctrl>(< >) key of your 
computer keyboard and double-click this, the Selected Channel window will open as an 
additional view.

GChannel name
This is a text box that displays the channel name. You can also edit the channel name in this 
text box. You can right-click (<control> key + click) the text box to select a channel color.

A
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MIX window

In this window you can view and edit the parameters of MIX channels 1–16. The parameters shown in the window can be 
selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the window.

You can access this window in the following ways.
• From the [Windows] menu, choose [Overview] and then choose “MIX”
• Use the bank select keys in the Master window to turn on the [MIX] button

1Output Patch
Click here to select the output port that will be assigned to the MIX channel, from the fol-
lowing choices.

If multiple patches have been made, only the first port is shown.
If you change the patching in this window, the port that had been assigned until then will be 
cancelled, and only the newly selected port will be assigned.

2 EQ (Equalizer)
Switches the EQ on/off. This is the same as the equalizer for INPUT CH (➥ p.13.)

3DYNA1 (Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT CH 
(➥ p.13.)

4 INSERT
Enables/disables the insert-in.

NONE No assignment

DANTE 1–32, DANTE 33–64 (only QL5)
DANTE OUTPUT 1–32, DANTE OUTPUT 33–64 
(only QL5)

OMNI 1–8, OMNI 9–16 (only QL5)
OMNI OUT jacks 1–8, OMNI OUT jacks 9–16 
(only QL5)

REC L, REC R L/R inputs of RECORDER

SLOT1-1, SLOT1-2...SLOT2-16 Output channels of an I/O card installed in slot 1–2

FX1L(A), FX1R(B)...FX1L(A), FX8R(B) L/R inputs of EFFECT rack 1–8

PR1L(A), PR1R(B)...PR8L(A), PR8R(B) L/R inputs of PREMIUM rack 1–8

DIGI L, DIGI R L/R channels of the DIGITAL OUT jack

1

2

3

4
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5MATRIX (MATRIX SEND)
These bar graphs indicate the send levels of the signals sent from the 
MIX channel to MATRIX 1–8 bus. You can also adjust the send levels 
by dragging a bar graph to left or right. While you drag the bar graph, 
the send level is shown in the numerical display area for TO STEREO/
MONO.
You can set the minimum value (–∞ dB) by holding down the 
<Ctrl>(< >) key of your computer keyboard and clicking the bar 
graph, or set the nominal value (0.00 dB) by holding down the 
<Ctrl>(< >) key and <Shift> key and clicking the bar graph.
The bar graph display will change as follows according to the send position (pre/post) and 
on/off status of the signal sent from the MIX channel to the MATRIX buses.
To switch a send on/off, click the channel number located at the left of the bar graph.

6PAN/BALANCE/ST/M(C)
The PAN knob adjusts the panning of the signal that is sent from the mix channel to the 
STEREO bus L/R channels (or the L/C/R channels.) You can set this to the center value by 
holding down the <Ctrl>(< >) key of your computer keyboard and clicking this knob. If 
assigned as a stereo bus, this adjusts the balance of the odd-numbered channel and even-
numbered channel. The stereo bus setting can be made in Mix Bus Setup of the Mixer Setup 
dialog box.
The [ST] button is an on/off switch for the signal that is sent from the mix channel to the 
STEREO bus.
The [M(C)] button is an on/off switch for the signal that is sent from the mix channel to the 
MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will appear 
instead of the [ST] button and [MONO] button, and the [LCR] button will be an on/off 
switch for the signal that is sent from the mix channel to the LCR bus.

7VARI/FIXED
Indicates the type (VARI or FIXED) of the currently selected MIX bus. This parameter can 
be switched in Mix Bus Setup of the Mixer Setup dialog box.

8 SEL (Channel selection)
Selects the MIX channel for which you want to make settings. 

9CUE
This button cue-monitors the signal of the MIX channel. 

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

0ON
Switches the MIX channel on/off. 
The button is color-coded and indicates status as follows:

White: MIX channel is on (normal mode.)
Black: MIX channel/Send is off.
Other colors: Send is on (SENDS ON FADER mode.)

A Fader
Adjusts the output level of the MIX channel. The current fader value is shown in the 
numeric box immediately below the fader. You can set this to the minimum value (–∞ dB) 
by holding down the <Ctrl>(< >) key of your computer keyboard and clicking the fader 
knob, or set it to the nominal value (0.00 dB) by holding down the <Ctrl>(< >) key and 
<Shift> key and clicking the fader knob.

6
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• Post/on (orange)

• Post/off (orange)
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The numbers and alphabetical letters at the right of the fader indicate the mute groups to 
which that channel belongs, and show the Recall Safe and Mute Safe status of the channel.

Click the indicator area to switch between 3 indicators.

The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the MIX channel (normal mode.)
Gray: MIX channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)

BChannel number
Indicates the number of the MIX channel. You can double-click this number to open the 
Selected Channel window for this channel. If you hold down the <Ctrl>(< >) key of your 
computer keyboard and double-click this, the Selected Channel window will open as an 
additional view.

CChannel name
This is a text box that displays the channel name. You can also edit the channel name in this 
text box. You can right-click (<control> key + click) the text box to select a channel color.

The numbers of mute groups to 
which this channel belongs are 
shown in red when those groups 
are muted. If the dimmer levels for 
those groups are set in a non-
default status, those are shown in 
orange.

If this channel is set 
to Recall Safe, the 
R character is 
shown in green.

If this channel is set to Mute Safe, 
the M character is shown in green.

This level meter is dis-
played at the same 
metering point with the 
input channel in Meter 
window setup (➥ p.72.)

Mute Group 
indicator Level Meter

Mute Safe/
Recall Safe 
indicator

NOTE
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MATRIX window

In this window you can view and edit the parameters of MATRIX channels 1–8. The parameters shown in the window can 
be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the window.

You can access this window in the following ways.
• From the [Windows] menu, choose [Overview] and then choose “MATRIX”
• Use the bank select keys in the Master window to turn on the [MTRX] button

1MIX/CH/ST IN (Send levels from the MIX/INPUT CH/ST IN to 
the MATRIX bus)
This switches between indicating the sends from MIX channels 1–16, the sends from 
INPUT CH 1–16/17–32/33–48 (QL5)/49-64 (QL5), and the sends from ST IN.

The bar graphs located immediately below the button indicate/adjust the level of the signal 
that is sent from each channel to the MATRIX bus. The method of operation and the mean-
ing of the display are the same as for (5) MATRIX in the MIX window (➥ p.18.)

1
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2 STEREO (Send levels from the STEREO channels to the MATRIX 
bus)
Here you can view and edit the send levels of the signals sent from the STEREO channels to 
the MATRIX bus. While you drag the bar graph, the send level is shown in the numerical 
display area immediately below. The method of operation and the meaning of the display 
are the same as for (5) MATRIX in the MIX window (➥ p.18.)

3 EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approximate 
response of the EQ. This is the same as the equalizer for INPUT CH (➥ p.13.)

4DYNA1 (Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT CH 
(➥ p.13.)

5 INSERT
Enables/disables the insert-in.

6 SEL (Channel selection)
Selects the MATRIX channel for which you want to make settings. 

7CUE
This button cue-monitors the signal of the MATRIX channel. 

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

8ON
This switches the MATRIX channel on/off. 
If the corresponding channel is off, the fader will be grayed out.

9 Fader
This adjusts the output level of the MATRIX channel. The current fader value is shown in 
the numeric box immediately below the fader. 
The numbers and alphabetical letters at the right of the fader indicate the mute groups to 
which that channel belongs, and show the Recall Safe and Mute Safe status of the channel. 
(For the significance of the numbers and alphabetical letters, see ➥ p.18.)

Click the indicator area at the right side of the fader to switch between 3 
indicators (mute group indicator, mute safe/recall safe indicator, level 
meter).

0Channel number
Indicates the number of the MATRIX channel. You can double-click this number to open 
the Selected Channel window for this channel. If you hold down the <Ctrl>(< >) key of 
your computer keyboard and double-click this, the Selected Channel window will open as 
an additional view.

AChannel name
This is a text box that displays the channel name. You can also edit the channel name in this 
text box. You can right-click (<control> key + click) the text box to select a channel color.
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STEREO/MONO window

In this window you can view and edit the parameters of the STEREO and MONO channels. The parameters shown in the 
window can be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in 
the window.

You can access this window in the following ways.
• From the [Windows] menu, choose [Overview] and then choose “STEREO/MONO”
• Use the bank select keys in the Master window to turn on the [ST] button

1 EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked.) This is the same as the equalizer for 
INPUT CH (➥ p.13.)

2DYNA1 (Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT CH 
(➥ p.13.)

3 INSERT
Enables/disables the insert-in. (The L/R settings are linked.)

4MATRIX (MATRIX SEND)
Here you can view and edit the send levels of the signals sent from the STEREO/MONO 
channel to MATRIX 1–8 bus. The method of operation and the meaning of the display are 
the same as for MATRIX in the MIX window (➥ p.18.)

1

3

4
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5BALANCE
Adjusts the left/right balance of the STEREO channel.
For MONO channels, this control indicates the send level to the MATRIX bus.

6 SEL (Channel selection)
Selects the channel for which you want to make settings. (You can specify L and R indepen-
dently.) 

7CUE
This button cue-monitors the signal of the STEREO/MONO channel. 

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

8ON
This switches the STEREO/MONO channel on/off.
The button is color-coded and indicates status as follows:

White: STEREO/MONO channel is on (normal mode.)
Black: STEREO/MONO channel/Send is off.
Other colors: Send is on (SENDS ON FADER mode.)

9 Fader
Adjusts the output level of the STEREO/MONO channel. 
The current fader value is shown in the numeric box immediately below the fader.
The numbers and alphabetical letters at the right of the fader indicate the mute groups to 
which that channel belongs, and show the Recall Safe and Mute Safe status of the channel. 
(For the significance of the numbers and alphabetical letters, see ➥ p.18.)

Click the indicator area at the right side of the fader to switch between 3 
indicators (mute group indicator, mute safe/recall safe indicator, level 
meter).

The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the STEREO/MONO channel (normal 

mode.)
Gray: STEREO/MONO channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)

0Channel number
This is the channel number (ST or M.) You can double-click this number to open the 
Selected Channel window for this channel. If you hold down the <Ctrl>(< >) key of your 
computer keyboard and double-click this, the Selected Channel window will open as an 
additional view.

AChannel name
This is a text box that displays the channel name. You can also edit the channel name in this 
text box. You can right-click (<control> key + click) the text box to select a channel color.
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DCA window

In this window you can view and edit the parameters of DCA (Digital-Controlled Amplifier) groups 1–16.

You can access this window in the following ways.
• From the [Windows] menu, choose [Overview] and then choose “DCA”
• Use the bank select keys in the Master window to turn on the [DCA] button

1CUE
This button cue-monitors all channels that are assigned to the DCA group.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

2ON
If you turn this button off, no signal will be output from the channels assigned to the DCA 
group. If you turn this button on, that status will be cancelled.

3DCA fader
This fader adjusts the level of the DCA group.
The current fader value is shown in the numeric box immediately below the fader.
You can set this to the minimum value (–∞ dB) by holding down the <Ctrl>(< >) key of 
your computer keyboard and clicking the fader knob, or set it to the nominal value 
(0.00 dB) by holding down the <Ctrl>(< >) key and <Shift> key and clicking the fader 
knob. If the fader is at nominal level, the green indicator at the right of the fader will light.
If a DCA group is set to Recall Safe, the R character at the lower right of the fader is dis-
played in green.

4DCA number
This is the number of the DCA group. 

5DCA group name
This is a text box that displays the DCA group name. You can also edit the DCA group name 
in this text box. You can right-click (<control> key + click) the text box to select a channel 
color.

6 Level Meter
This level meter indicates the post-meter of DCA.

Click the level meter area to switch between the recall-safe indicator and 
the level meter.
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Here you can set the parameters of the currently selected input channel (INPUT CH 1–64(*), ST IN channels 1–8) or out-
put channel (MIX channels 1–16, MATRIX channels 1–8, STEREO/MONO channels.)
You can access this window in the following ways.

• From the [Windows] menu, choose [Selected Channel] and select “Main View”
• Double-click the channel number, EQ, DYNA1, or DYNA2 button in one of the Overview windows.

By choosing [Selected Channel] from the [Windows] menu and then selecting “Additional View,” you 
can view a window for a channel that is not selected. This Additional View is not linked with [SEL] button 
operations on the panel of the QL.

The type of parameters that can be edited in this window depends on the type of the currently selected channel. The 
parameters of the Selected Channel window are explained below, in the order of input channels (input channels 1–64(*), 
ST IN channels 1–8), or output channels (MIX channels 1–16, MATRIX channels 1–8, and STEREO/MONO channels.)

(*) QL1: 1–32

If an input channel is selected

Selected Channel window

NOTE

● INPUT CH window
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Unless otherwise specified, the parameters explained below are common to INPUT CH 1–64 
(QL1: 1–32) and ST IN channels 1–8.

❏CHANNEL SELECT (Channel selection)

1 SELECT (Channel selection)
Indicates the number and name of the channel you are editing. To switch channels, you can either click the [SELECT] 
button and choose from the list that appears, or you can click the plus/minus (+/–) channel select buttons on the left or 
right side of the icon. You can right-click (<control> key + click) the icon and select the desired choice. If you left-click 
the icon, you can select the channel color. You can also edit the channel name in the text box.

2 LIBRARY
Accesses the Input Channel Library. Click this button to open the INPUT CH page of the Library window.

3PATCH (Input patch)
Selects the input source assigned to the input channel (for the selectable input sources, ➥ p.12.)

● ST IN channel window

NOTE

2
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❏TO MIX/TO MATRIX SEND

1MIX/MATRIX send level
This adjusts the send level of the signal sent from the input channel to VARI-type MIX bus and MATRIX bus. The cur-
rent value is shown in the numerical box immediately below.

2PRE (PRE on/off)
This selects PRE or POST as the point from which the signal is sent from the input channel to the MIX bus and 
MATRIX bus. The point will be PRE EQ or PRE FADER when this is on, and POST FADER when this is off. The PRE 
EQ/FADER setting can be specified in the Mixer Setup dialog box.

You can right-click (<control> key + click) the PRE button to display a context-sensitive menu that will 
enable you to specify ALL PRE, ALL POST, or other options.

3ON (MIX/MATRIX send on/off)
This is an on/off switch for the signal sent from the input channel to the MIX bus and MATRIX bus.

• When MIX buses or MATRIX 
buses are being used in stereo, 
the odd-numbered knob will be 
PAN or BAL (BALANCE.) If the 
INPUT CH is selected, the odd-
numbered knob will be always 
PAN. If the ST IN is selected, the odd-numbered will be PAN or BAL. 
You can switch between Pan and Balance in the TO STEREO/MONO section.

• If the FIXED type is selected for the MIX bus, only the ON button is valid.

• The stereo/mono setting and the VARI type/FIXED type setting can be 
made in the Mixer Setup dialog box.

4Channel name
This section indicates the name of the MIX channel or MATRIX channel.

❏HA/D.GAIN/HPF/Ø/GC
1HA (HA analog gain)

Adjusts the analog gain of the internal head amp or of the external 
head amp patched to the input channel. The current value is shown 
in the numerical box below the knob. You can set this to the default 
value (– 6dB) by holding down the <Ctrl>(< >) key and clicking 
the knob. You can also use the [48V] button to switch phantom 
power on/off.

2D.GAIN (Digital Gain)
Drag the knob in the screen to adjust the digital gain (input gain) of 
the input channel.

3HPF (High Pass Filter)
Use the [ON] button at the right to switch the high-pass filter on/off. You can use the knob at left to adjust the cutoff 
frequency. The current value is shown in the numerical box below the knob. An indication of “H” will appear on the 
EQ graph of the equalizer.

4GC (Gain Compensation)
This is an on/off switch for the head amp’s analog gain correction. This function maintains a specific level for the audio 
signal on the network when the same I/O rack or built-in head amp of the QL unit are being shared by multiple QL/CL 
series units. This button will be displayed only if the DANTE or INPUT ports have been patched.
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5A.GAIN-D.GAIN Link
This is an on/off switch for linking the analog gain and digital gain when gain compensation is on.

6Ø (Phase)
Inverts the phase polarity of the signal after AD conversion.

7HPF Type
Switches the attenuation (per octave) of the high pass filter between –12dB/oct and –6dB/oct.

❏TO STEREO/MONO
Here you can specify how the signal will be sent from the input channel to the STEREO bus/MONO bus.

MODE

• ST/MONO button
When this button is on, the signal will be sent to the STEREO L/R bus and independently to the MONO bus.

• LCR button
When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

PAN 
(PAN/BALANCE for ST IN)

The PAN knob adjusts the panning of the signal sent from the input channel to the STE-
REO bus L/R channels. You can set this to the center position by holding down the 
<Ctrl>(< >) key of the computer keyboard and clicking the knob. You can select Pan or 
Balance for ST IN. The BALANCE knob adjusts the balance of the signal that is sent from 
the ST IN channel to the STEREO bus L/R channels. PAN/BALANCE can be switched 
with the [PAN]/[BALANCE] buttons.

ST Switches the signal sent from the input channel to the STEREO bus on/off.

M(C) Switches the signal sent from the input channel to the MONO bus on/off.

PAN 
(PAN/BALANCE for ST IN)

The PAN knob adjusts the panning of the signal that is sent from the input channel to each 
of the L/C/R channels. You can set this to the center position by holding down the 
<Ctrl>(< >) key of the computer keyboard and clicking the knob. You can select Pan or 
Balance for ST IN. The BALANCE knob adjusts the balance of the signal that is sent from 
the ST IN channel to the STEREO bus L/R channels. PAN/BALANCE can be switched 
with the [PAN]/[BALANCE] buttons.

CSR (Center Side Ratio)
Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a 
range of 0–100%.

[INPUT CH 1–64] [ST IN channel 1–8]

[INPUT CH 1–64] [ST IN channel 1–8]
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❏EQ (EQUALIZER)

1 LIBRARY
Accesses the INPUT EQ page of the Library window.

2ON
Switches the EQ (Parametric Equalizer) on/off of the currently selected channel.

3 EQ graph
Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down the 
<Ctrl>(< >) key of your computer keyboard and click the graph (The HPF setting will remain.)

4Q
These knobs adjust the Q level of the frequency range selected in the EQ graph.

5 FREQ (FREQUENCY)
These knobs adjust the center frequency for the four bands LOW, LO-MID, HI-MID, and HIGH.

6GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID, and 
HIGH.

7  HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear.)

8  LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear, and the 
GAIN knob will act as the low pass filter on/off switch.

9  LOW shelving
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear.)

0TYPE I/TYPE II (EQ type)
Selects either TYPE I or TYPE II as the EQ type.

AATT (Attenuation)
Adjusts the amount of attenuation for the signal level of pre EQ.

4

7

8

9

21

3

6
5

A0



QL Editor Owner’s Manual30

❏DYNAMICS1/2
You can select one of the following types for each of the two dynamics processors.

If GATE/DUCKING is selected

1TYPE
Indicates the type of the currently selected gate/ducking. You can click here to select the type. Ducking is the effect that 
activates compressor triggered by another sound source.

2 LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

3ON
This button switches on/off for the gate or the ducking.

4Response curve
Indicates the response for the gate/ducking of the currently selected channel.

5GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the gate/ducking.

6THRESH (Threshold level)
Specifies the level (the threshold level) at which the gate/ducking will activate. The gate will open (or the ducking will 
activate) when the key-in signal exceeds this level, and the gate will close (or the ducking will deactivate) when the sig-
nal falls below this level.

7RANGE
Specifies the amount by which the signal is attenuated while the gate is closed (or while the ducking is activated.)

8DECAY
Specifies the time over which the gate will close (or the time to return to normal signal gain of ducking) after the hold 
time has elapsed.

9ATTACK
Specifies the time from when the key-in signal exceeds the threshold level until the gate opens (or from when the duck-
ing has been triggered until the signal is ducked.)

0HOLD
Specifies the time that the gate will remain open (or the ducking will remain activate) after the key-in signal falls below 
the threshold.

DYNAMICS1 GATE, DUCKING, COMPRESSOR, EXPANDER

DYNAMICS2 COMPRESSOR, COMPANDER-H, COMPANDER-S, DE-ESSER
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AKEY IN SOURCE
Click this to select one of the following signals to use as the key-in source.

BCUE
This button cue-monitors the currently selected key-in signal. This is not shown in the Additional View.

If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is not checked, the 
[CUE] button will be hidden in the screen.

CKEY IN FILTER
Select the type of filter applied to the selected key-in signal; HPF (high pass filter), BPF (band pass filter), or LPF (low 
pass filter.) The ON/OFF button switches the filter on/off.
If you’ve selected BPF, use the two knobs to adjust the band pass frequency and Q. If you’ve selected HPF or LPF, use 
the knob to adjust the cutoff frequency.

If COMPRESSOR/EXPANDER is selected

1TYPE
Indicates the currently selected compressor or expander. You can click here to select the type.

2 LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

3ON
This button switches on/off for the compressor or the expander.

4Response curve
Indicates the response for the compressor/expander of the currently selected channel.

5GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the compressor/expander.

6THRESH (Threshold level)
Specifies the threshold level at which the compressor/expander will operate. If the compressor is selected, the input sig-
nal will start being compressed when the key-in signal exceeds this level; compression will be removed when the signal 
falls below this level. If the expander is selected, the input signal will start being compressed when the key-in signal falls 
below this level; compression will be removed when the signal exceeds this level.

SELF PRE EQ The pre-EQ signal of the currently selected input channel

SELF POST EQ The post-EQ signal of the currently selected input channel

MIX OUT 13–16
The output signal of the corresponding MIX channel immediately before the output attenua-
tion

CH 1–64 POST EQ The post-EQ signal of the corresponding input channel (however, you can only choose chan-
nels belonging to the same group, within the ten groups CH1–8, CH9–16, CH17–24, 
CH25–32, CH33–40, CH41–48, CH49-56, CH57-64, STIN1L–STIN4R, and 
STIN5L–STIN8R)

STIN1L–STIN8R POST EQ

NOTE
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7RATIO
If the compressor is selected, specifies the ratio at which the input signal will be compressed when the key-in signal 
exceeds the threshold. If the expander is selected, specifies the ratio at which the input signal will be compressed when 
the key-in signal falls below the threshold.

8KNEE
Specifies the sharpness at which the output level will change. You can select from HARD or 1–5.

9ATTACK
If the compressor is selected, specifies the time (the attack time) from when the key-in signal exceeds the threshold 
level until the signal starts being compressed. If the expander is selected, specifies the time (the attack time) from when 
the key-in signal falls below the threshold level until the signal starts being compressed.

0GAIN
Adjusts the gain of the signal after it has passed through the compressor/expander.

ARELEASE
If the compressor is selected, specifies the time (the release time) from when the key-in signal falls below the threshold 
level until compression is removed. If the expander is selected, specifies the time (the release time) from when the key-
in signal exceeds the threshold level until compression is removed.

BKEY IN SOURCE
Click this to select the key-in signal that you want to use.
The choices are the same as for GATE.

If COMPANDER-H, COMPANDER-S is selected

1TYPE
Indicates the type of the currently selected compander (a combination of compressor and expander.) You can click here 
to select the type.

2 LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

3ON
This button switches the compander on/off.

4Response curve
Indicates the response for the compander of the currently selected channel.

5GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the compander.

6THRESH (Threshold level)
Specifies the threshold level at which compression and expansion are applied. The input signal will be compressed 
when the key-in signal exceeds this level. The expander effect will apply to levels below THRESHOLD + WIDTH.

1
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7RATIO
Specifies the ratio (the amount of compression.)

8WIDTH
Specifies the width between the threshold level of the compressor (THRESHOLD) and the threshold level of the 
expander.

9ATTACK
Specifies the time (the attack time) until it starts to compress and expand the input signal once the compander has been 
triggered.

0GAIN
Adjusts the gain of the signal after it has passed through the compander.

ARELEASE
Specifies the time (the release time) from when the key-in signal falls below the threshold level until compression and 
expansion are removed.

BKEY IN SOURCE
Click this to select the key-in signal that you want to use.
The choices are the same as for GATE.

If DE-ESSER is selected

1TYPE
This indicates that De-Esser is the currently selected type.

2 LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

3ON
This button switches the de-esser on/off.

4Response curve
Indicates the response for the de-esser of the currently selected channel.

5GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the de-esser.

6THRESH (Threshold level)
Specifies the threshold level at which the de-esser will operate. The input signal will start being compressed when the 
key-in signal exceeds this level; compression will be removed when the signal falls below this level.

7 FREQ (Minimum frequency/Center frequency)
Specifies the minimum frequency (for HPF) or the center frequency (for BPF) at which the key-in signal will activate 
the de-esser.
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8TYPE
Drag the knob in the screen to select the HPF (High Pass Filter) or BPF (Band Pass Filter.)

9Q
Adjust the Q level of the frequency range at which the key-in signal will activate the de-esser.
This parameter is valid only if the TYPE is set to BPF.

0KEY IN SOURCE
The key-in signal is set to the SELF POST EQ.

❏DELAY

1ON
Turns the delay on/off of the currently selected channel.

2Delay time
Drag the knob in the screen to adjust the delay time of the currently selected channel.

❏ INSERT1/2 (except for ST IN channels)

1POINT (Insert point)
Selects the position at which insert-in/out will be patched. Choose from PRE EQ, PRE FADER, or POST ON.

2ON
Enables/disables insert-in/out.

3OUT (Insert out)
Click this to select the output port that will be assigned to insert-out, from the following choices.
NONE No assignment

DANTE 1–32, DANTE 33–64 (only QL5) DANTE OUTPUT 1–32, DANTE OUTPUT 33–64 (only QL5)

OMNI 1–8, OMNI 9–16 (only QL5) OMNI OUT jacks 1–8, OMNI OUT jacks 9–16 (only QL5)

SLOT1-1, SLOT1-2...SLOT2-15, SLOT2-16 Output channels of an I/O card installed in slots 1–2

GEQ1L(A), GEQ1R(B)...GEQ8L(A), GEQ8R(B) L/R outputs of GEQ rack 1–8

FX1L(A), FX1R(B)...FX8L(A), FX8R(B) L/R inputs of EFFECT rack 1–8

PR1L(A), PR1R(B)...PR8L(A), PR8R(B) L/R inputs of PREMIUM rack 1–8

DIGI L, DIGI R L/R channels of the DIGITAL OUT jack

12
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4 IN (Insert in)
Click this to select the input port that will be assigned to insert-in, from the following choices.

5HA (HA analog gain)
Adjusts the analog gain for INPUT. This knob appears only if the channel is patched to a head amp.

648V (Phantom power)
Switches phantom power (+48V) on/off. This button appears only if the channel is patched to a head amp.

7GC (Gain Compensation)
Turns head amp analog gain compensation on/off.

❏DIRECT OUT (except for ST IN channels)

1ON
Turns the direct output on/off. You can right-click (<control> key + click) the button to display a popup menu and 
select ALL ON or ALL OFF.

2DIRECT OUT GAIN
Adjusts the gain of the direct output. The current value is shown in the numerical box below the knob. You can set this 
to the nominal value (0.0 dB) by holding down the <Ctrl>(< >) key and clicking the knob.

3DIRECT OUT PORT
Click this to select one of the following output ports as the one used for direct out.

4DIRECT OUT POINT
Selects the position at which direct out will be patched. Choose from PRE HPF, PRE EQ, PRE FADER, or POST ON.

NONE No assignment

DANTE 1–32, DANTE 33–64 (only QL5) DANTE INPUT 1–32, DANTE INPUT 33–64 (only QL5)

INPUT 1–16, INPUT 17–32, (only QL5) INPUT jacks 1–16, INPUT jacks 17–32 (only QL5)

SLOT1-1, SLOT1-2...SLOT2-15, SLOT2-16 Input channels of an I/O card installed in slots 1–2

GEQ1L(A), GEQ1R(B)...GEQ8L(A), GEQ8R(B) L/R outputs of GEQ rack 1–8

FX1L(A), FX1R(B)...FX8L(A), FX8R(B) L/R outputs of EFFECT rack 1–8

PR1L(A), PR1R(B)...PR8L(A), PR8R(B) L/R outputs of PREMIUM rack 1–8

NONE No assignment

DANTE 1–32, DANTE 33–64 (only QL5) DANTE OUTPUT 1–32, DANTE OUTPUT 33–64 (only QL5)

OMNI 1–8, OMNI 9–16 (only QL5) OMNI OUT jacks 1–8, OMNI OUT jacks 9–16 (only QL5)

REC L, REC R L/R inputs of RECORDER

SLOT1-1, SLOT1-2...SLOT2-16 Output channels of an I/O card installed in slots 1–2

DIGI L, DIGI R L/R channels of the DIGITAL OUT jack

1

2 3 4
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❏RECALL SAFE/MUTE SAFE
These enable/disable Recall Safe and Mute Safe for the channel.

❏DCA GROUP/MUTE GROUP

1DCA GROUP
Selects the DCA group (1–16) to which that channel belongs.

2MUTE GROUP
Selects the mute group (1–8) to which that channel belongs.

3DCA/MUTE
These buttons enable/disable DCA group and Mute group for the 
channel.

❏Fader

1ON
Switches the input channel on/off. 
If the corresponding channel is off, the fader will be grayed out.

2 Fader
Adjusts the input level of the input channel. A meter indicating the signal level is shown at 
the right of the fader, and the current value is shown in the numerical box immediately 
below. You can set this to the minimum value (–∞ dB) by holding down the <Ctrl>(< >) 
key of your computer keyboard and clicking the fader knob, or set it to the nominal value 
(0.00 dB) by holding down the <Ctrl>(< >) key and <Shift> key and clicking the fader 
knob.

3CUE
This button cue-monitors the signal of the input channel. 

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

1 2
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If a MIX channel is selected

❏CHANNEL SELECT (Channel selection)
1 SELECT (Channel selection)

Except for the fact that your editing applies to a MIX channel, this is the 
same as the channel selection for an input channel (➥ p.26.)

2 LIBRARY
Accesses the Output Channel Library. Click this button to open the 
OUTPUT CH page of the Library window.

3PATCH (Output patch)
Selects the output source assigned to the Mix channel (for the selectable 
output sources, ➥ p.17.)

❏TO MATRIX
1 MATRIX send level

This adjusts the send level of the signal sent from the MIX channel to the MATRIX buses.
2 PRE (PRE on/off)

Select either PRE or POST as the position from which the signal is sent from the MIX 
channel to the MATRIX bus. PRE EQ or PRE FADER is selected if this is on, or POST 
FADER is selected if this is off. The PRE EQ/PRE FADER setting can be made in the Mixer 
Setup dialog box.

You can right-click (<control> key + click) the PRE button to display a context-sen-
sitive menu that will enable you to specify ALL PRE, ALL POST, or other options.

• If you are using MATRIX buses in stereo, 
the knob for the odd-numbered bus will be 
PAN or BALANCE.

• The stereo/mono status can be specified in
the Mixer Setup dialog box.

3 ON (MATRIX send on/off)
This is an on/off switch for the signal sent from the MIX channel to the MATRIX bus.

4 Channel name
This section indicates the MATRIX channel name.

1 2

3

2
1

3

4

NOTE

HINT

Knob of odd-numbered side



QL Editor Owner’s Manual38

❏TO STEREO/MONO
Here you can specify how the signal will be sent from the MIX channel to the STEREO bus/MONO bus.

MODE

• ST/MONO button
When this button is on, the signal will be sent to the STEREO bus and independently to the MONO bus.

• LCR button
When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

PAN (BALANCE for 
STEREO bus)

The PAN knob adjusts the panning of the signal sent from the MIX channel to the STE-
REO bus L/R channels. You can set this to the center position by holding down the 
<Ctrl>(< >) key of the computer keyboard and clicking the knob. If the selected MIX bus 
is used as a stereo bus, this will be the BALANCE. The BALANCE knob adjusts the bal-
ance of the signal that is sent from the MIX channel to the STEREO bus L/R channels.

ST Switches the signal sent from the MIX channel to the STEREO bus on/off.

M(C) Switches the signal sent from the MIX channel to the MONO bus on/off.

PAN (BALANCE for 
STEREO bus)

The PAN knob adjusts the panning of the signal that is sent from the MIX channel to each 
of the L/C/R channels. You can set this to the center position by holding down the 
<Ctrl>(< >) key of the computer keyboard and clicking the knob. If the selected MIX bus 
is used as a stereo bus, this will be the BALANCE. The BALANCE knob adjusts the bal-
ance of the signal that is sent from the MIX channel to the STEREO bus L/R channels.

CSR (Center Side Ratio)
Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a 
range of 0–100%.

[for MONO mix channel] [for STEREO mix channel]

[for MONO mix channel] [for STEREO mix channel]
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❏EQ (Equalizer)

1 LIBRARY
Accesses the OUTPUT EQ page of the Library window.

2ON
Switches the EQ on/off.

3 EQ graph
Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down the 
<Ctrl>(< >) key of your computer keyboard and click the graph.

4Q
These knobs adjust the Q level of the frequency range selected in the EQ graph.

5 FREQ (FREQUENCY)
These knobs adjust the center frequency for the four bands LOW, LO-MID, HI-MID, and HIGH.

6GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID, and 
HIGH.

7  HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear.)

8  LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear, and the 
GAIN knob will act as the low pass filter on/off switch.

9  (LOW shelving)
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear.)

0  HPF (High Pass Filter)
If this button is on, the LOW EQ will function as a high pass filter EQ. The Q knob of the LOW EQ will disappear, and 
the GAIN knob will act as the high pass filter on/off switch.

ATYPE I/TYPE II (EQ type)
Selects either TYPE I or TYPE II as the EQ type.

BATT (Attenuation)
Adjusts the amount of attenuation for the signal level of pre EQ.
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❏DYNAMICS1
Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S, and that 
you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (➥ p.30.)

❏ INSERT
Except for the fact that the insert ports that can be selected are different, this is the same as for the insert settings of an 
input channel (➥ p.34.)

❏RECALL SAFE/MUTE SAFE
These are the same as the Recall Safe and Mute Safe functions for input channels.

❏MUTE GROUP
Selects the mute group (1–8) to which the MIX channel belongs.

❏Fader

1ON
Switches the MIX channel on/off. 

2 Fader
Adjusts the output level of the MIX channel. A meter indicating the signal level is shown at 
the right of the fader, and the current value is shown in the numerical box immediately 
below. You can set this to the minimum value (–∞ dB) by holding down the <Ctrl>(< >) 
key of your computer keyboard and clicking the fader knob, or set it to the nominal value 
(0.00 dB) by holding down the <Ctrl>(< >) key and <Shift> key and clicking the fader 
knob.

3CUE
This button cue-monitors the signal of the MIX channel.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

1
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NOTE
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If a MATRIX channel is selected

❏CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a MATRIX channel, this is the same as the channel selection for a MIX 
channel (➥ p.37.)

❏FROM MIX, ST/MONO(C)

1 FROM MIX, ST/MONO(C) send level
These adjust the send levels of the signals sent from the MIX 
buses or STEREO/MONO buses to the MATRIX bus. The cur-
rent value is shown in the numerical box immediately below.

2PRE (PRE on/off)
These select either PRE or POST as the position from which the 
signal is sent from the MIX buses or STEREO/MONO buses to 
the MATRIX bus. PRE EQ or PRE FADER is selected if this is 
on, or POST FADER is selected if this is off. The PRE EQ/
FADER setting can be made in the Mixer Setup dialog box.

3ON(FROM MIX, ST/MONO send on/off)
These are on/off switches for the signal sent from the MIX buses 
or STEREO/MONO buses to the MATRIX bus.

4Channel name
This section indicates the name of the MIX channel or STEREO/
MONO channel.
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❏BALANCE
This is shown only if the selected MATRIX bus is being used as stereo. It 
adjusts the left/right volume balance of the stereo signal. You can set this to the 
center value by holding down the <Ctrl>(< >) key of your computer key-
board and clicking this knob.

❏EQ (Equalizer)
This is the same as for the equalizer of a MIX channel (➥ p.39.)

❏DYNAMICS1
Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S, and that 
you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (➥ p.30.)

❏ INSERT
Except for the fact that the insert ports that can be selected are different, this is the same as for the insert settings of an 
input channel (➥ p.34.)

❏RECALL SAFE/MUTE SAFE
These are the same as the RECALL SAFE/MUTE SAFE of a MIX channel (➥ p.40.)

❏MUTE GROUP
These are the same as the MUTE GROUP of a MIX channel (➥ p.40.)

❏Fader

1ON
This switches the MATRIX channel on/off.

2 Fader
This adjusts the output level of the MATRIX channel. A meter indicating the signal level is 
shown at the right of the fader, and the current value is shown in the numerical box imme-
diately below. You can set this to the minimum value (–∞ dB) by holding down the 
<Ctrl>(< >) key of your computer keyboard and clicking the fader knob, or set it to the 
nominal value (0.00 dB) by holding down the <Ctrl>(< >) key and <Shift> key and click-
ing the fader knob.

3CUE
This button cue-monitors the signal of the MATRIX channel. 

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.
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If a STEREO/MONO channel is selected

❏CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a STEREO/MONO channel, this is the same as the channel selection for 
a MIX channel (➥ p.37.)

❏TO MATRIX
These are the same as the TO MATRIX of a MIX channel (➥ p.37.)

● STEREO channel window

● MONO channel window
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❏BALANCE (except for MONO channel)
This adjusts the left/right volume balance in the STEREO bus. You can set this 
to the center value by holding down the <Ctrl>(< >) key of your computer 
keyboard and clicking this knob.

❏EQ (Equalizer)
This is the same as the equalizer settings of a MIX channel (➥ p.39.)

❏DYNAMICS1
Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S, and 
that you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels 
(➥ p.30.)

❏ INSERT
Except for the fact that the insert ports that can be selected are different, this is the same as for the insert settings of an 
input channel (➥ p.34.)

❏RECALL SAFE/MUTE SAFE
These are the same as the RECALL SAFE/MUTE SAFE of a MIX channel (➥ p.40.)

❏MUTE GROUP
These are the same as the MUTE GROUP of a MIX channel (➥ p.40.)

❏Fader

1ON
This switches the STEREO/MONO channel on/off. 

2 Fader
Adjusts the output level of the STEREO/MONO channel. A 
meter indicating the signal level is shown at the right of the 
fader, and the current value is shown in the numerical box 
immediately below. 

3CUE
This button cue-monitors the signal of the STEREO/MONO 
channel. 

If the Channel Select/Sends On Fader checkbox 
in the System Setup dialog box is not checked, 
the [CUE] button will be hidden in the screen.
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Here you can edit the QL’s various libraries. You can also load library files that were saved on a drive of your computer, edit 
the order or title of library items, recall the desired library data, or copy desired library data to a library within the QL.
This window is divided into DYNAMICS, INPUT EQ, OUTPUT EQ, EFFECT, GEQ (Graphic Equalizer), INPUT CH, and 
OUTPUT CH pages; to switch pages, click the tabs located at the top of the window. 
To display this window, choose [Library] from the [Windows] menu, and select either “DYNAMICS,” “INPUT EQ,” “OUT-
PUT EQ,” “EFFECT,” “GEQ,” “INPUT CH,” or “OUTPUT CH.”

Regardless of the file type of the opened file, executing SAVE or SAVE AS in this window will save only 
the library data relative to the opened tab.

1OPEN (Open a file)
Opens a library file located on a drive of your computer. Use this when you want to edit library data that you’ve saved 
on a USB flash drive.

2CLOSE (Close a file)
Closes the currently-open library file.

3 SAVE
Saves the currently-open library file on a drive of your computer. Use this to re-save an edited library on a USB flash 
drive, or to create a backup on the hard disk of your computer.

4 SAVE AS (Save under a different name)
Saves the currently-open library file under a different name on a drive of your computer.

5 File name
Indicates the file name of the currently-open library.

Library window

NOTE

5

1 2 3 4
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6 FILE
This list shows the contents of the data in the library file you opened using the OPEN button (1). The list includes the 
following items.

7No. (Number)
This column indicates the number of each item in the library.

8TITLE
This column indicates the title assigned to each library item. You can also double-click this area and edit the title.

9R (READ ONLY)
Read-only data is indicated by an “R” in this column. It cannot be overwritten, nor can its title be edited.

0TYPE
This column indicates the effect type.
In the case of dynamics, there is also an indication of the dynamics processor(s) of this channel into which each library 
item can be recalled. Only library items with an indication of “1” can be recalled to DYNAMICS 1, and only library 
items with an indication of “2” can be recalled to DYNAMICS 2. Library items with neither of these indications cannot 
be recalled to this channel.

ADYNAMICS (DYNAMICS page only)
Select which of the two dynamics processors will be subject to the Store or Recall operation.

BRACK No. (Rack selection) (Effect/GEQ page only)
Select which rack will be subject to the Store or Recall operation. In the EFFECT library, it indicates the rack number 
1–8 of the EFFECT rack. In the GEQ library, it indicates the rack number 1–8 of the GEQ and the rack number 1–8 of 
the EFFECT rack. If you select the rack number that Flex 15 GEQ is assigned to, it displays the A/B select button. And 
this A/B select button will be hidden if you select the rack number that 31 Band GEQ is assigned to.

HQ Pitch and Freeze cannot be recalled to an effect module mounted in the even-numbered rack.

6
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 (DYNAMICS page only)

 (Effect/GEQ page only)

NOTE
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C INTERNAL DATA
This area shows the QL’s library contents. The items displayed are the same as in the FILE list (6).
As desired, you can copy single or multiple data items between the FILE list and the INTERNAL DATA list, and copy or 
move them to a different location within a list.
To do this, use the following methods to select the data item(s) that you want to copy or move.

• To select a single data item
Click the line containing the desired data item.

• To select multiple consecutive data items
Click the first data item to select it; then hold down the <Shift> key and 
click the last data item.

• To select multiple non-consecutive data items
Click the first data item; then hold down the <Ctrl>(< >) key and click 
each of the remaining data items.

When you have selected the data item(s) that you want to move or copy, drag 
them to the desired location in the other list (if you’re copying between lists) 
or in the same list (if you’re copying/moving within the same list.)

• To copy data items (overwriting the destination)
Drag the copy-source data item(s) to the desired line in the other list or to 
another line in the same list. At this time, a  symbol will appear at the 
right of the data item number.
When you drop the data item in this state, a dialog box will appear, asking 
you to confirm the Save operation. If you click the OK button, the copy-
source data item(s) will be overwritten onto the copy-destination data 
items, and the copy-source data item(s) will remain unchanged. (If the 
copy-source selection contains multiple data items, the data will be over-
written onto consecutive data items starting at that data item.)

• To move data items
Within the same list, you can move the selected data item(s) to another 
location to rearrange the order of the data items in the list. To do this, 
drag the selected data item(s) to a location between two other lines in the 
same list. At this time, a  symbol will appear between the lines.
When you release the mouse button in this state, the selected data item(s) 
will move to that location, and the data item numbers will also change 
accordingly. (If the move-source selection contains multiple data items, 
those data items will be inserted consecutively at the location you spec-
ify.)

You cannot copy the Initial Data of the GEQ library.

D STORE
Stores the current settings to the data item that is selected in the list.

ERECALL
Recalls the data item that is selected in the list.

FCLEAR
Clears the data item(s) selected in the list.

GUNDO
Cancels the last-performed library recall, store, copy, or move operation.

NOTE
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Here you can edit the libraries of each EQ or compressor of the PREMIUM rack. You can also load library files that were 
saved on a drive of your computer, edit the order or title of library items, recall the desired library data, or copy desired 
library data to a library within the QL.
This window is divided into Portico5033, Portico5043, U76, Opt-2A, EQ-1A, and DynamicEQ pages; to switch pages, click 
the tabs located at the top of the window. To display this window, choose [Premium Rack Library] from the [Windows] 
menu, and select either “Portico5033,” “Portico5043,” “U76,” “Opt-2A,” “EQ-1A,” or “DynamicEQ.” 
The operating procedure is the same as for the Library window (➥ p.45.)

Regardless of the file type of the opened file, executing SAVE or SAVE AS in this window will save only 
the library data relative to the opened tab.

Premium Rack Library window

NOTE
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Here you can assign the input/output port for each channel, its direct output, and its insert-in/out.
This window is divided into INPUT PATCH, OUTPUT PATCH, INPUT INSERT PATCH, OUTPUT INSERT PATCH, 
DIRECT OUT PATCH, and PATCH LIST pages. To switch pages, click the tabs shown in the upper part of the window.
To display this window, choose [Patch Editor] from the [Windows] menu, and select either “INPUT PATCH,” “OUTPUT 
PATCH,” “INPUT INSERT PATCH,” “OUTPUT INSERT PATCH,” “DIRECT OUT PATCH,” or “PATCH LIST.”

INPUT PATCH page

Here you can select the input port that is assigned to the input of each input channel.

❏HA INFO
Specifies whether the HA setting for the input port will be copied from the original channel when you modify the patching.

1TAKE FROM PORT button
The HA setting will not be copied from the original channel. The HA setting for the port will remain the same, even if 
patching is changed.

2TAKE FROM CHANNEL button
The HA setting will be copied from the original channel. The HA setting for the previously-patched port will be applied 
to a newly-patched port.

❏PRESET
Initializes the patching in this page.

❏CLEAR ALL
Clears all patching in this page.

Patch Editor window

1

2
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OUTPUT PATCH page

Here you can select the input port that is assigned to the output of each output channel.

INPUT INSERT PATCH page

Here you can assign input/output ports to the insert-in/out of each input channel. Select the output port in the left side of 
the screen, and the input port in the right side of the screen. 

1 INSERT1/INSERT2
Switches between INSERT1 and INSERT2.

Output port selection Input port selection

1
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OUTPUT INSERT PATCH page

Here you can assign input/output ports to the insert-in/out of each output channel. Select the output port in the left side of 
the screen, and the input port in the right side of the screen. 

1 INSERT1/INSERT2
Switches between INSERT1 and INSERT2.

DIRECT OUTPUT PATCH page

Here you can select the output port that will directly output each input channel. 

Output port selection Input port selection

1
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PATCH LIST page

Here you can view and edit the input patch and output patch settings. 

1 Input channel number
This is the number of the input channel.

2 Input channel name
This is the name of the input channel. You can click the channel name box to edit the name in this page.

3 Input port
This shows the input port assigned to the input channel. You can click this box and choose the input port from the 
popup menu that appears.

4Output channel number
This is the number of the output channel.

5Output channel name
This is the name of the output channel. You can click the channel name box to edit the name in this page.

6Output port
This shows the output port assigned to the output channel. You can click this box, then choose or cancel the output port 
from the popup menu that appears.

You can assign multiple output ports. If you assign multiple output ports, it will display the first output 
port in the order of the pop-up menu.

1 2 3 4 5 6

NOTE
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Here you can make settings for GEQ (Graphic Equalizer), effects, and PREMIUM rack.
This window is divided into GEQ, EFFECT, and PREMIUM page. To switch pages, click the tabs located at the top of the 
window. 

GEQ page

1Mount
Select a GEQ module or automixer for mounting in the rack, from the following choices. 

BLANK No assignment

31BandGEQ 31-band 1-in/1-out graphic equalizer

Flex15GEQ 2-in/2-out graphic equalizer that allows any fifteen of the 31 bands to be controlled

8ch Automixer 8-channel automixer (can be mounted only in rack no. 1)

16ch Automixer 16-channel automixer (can be mounted only in rack no. 1)

Virtual Rack window

1 2 4

765

3
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2 Input patch
Select the input port (s) that will be assigned to the rack, from the following choices.

This is not shown if nothing is mounted in the rack.

3Module graphic
This area shows a graphic of the GEQ module or automixer that is currently assigned to the rack, and the parameters of 
that module. You cannot edit the parameters in this screen.
Double-click this to open the module editor for that rack unit.
By holding down the <Ctrl>(< >) key of your computer keyboard and double-clicking this, you can open multiple 
rack module editors. For these additional editors, the rack select buttons are not linked with the RACK popup window 
of the QL itself.

4Output patch
Select the output port(s) that will be assigned to the rack, from the following choices.

5GEQ Link Indicator
If a GEQ LINK is active, the GEQ Link indicator will be displayed in the left side of the rack (➥ p.57.)

6 Input meter/Output meter
These indicate the level of the signals being input and output from the rack.

7ON
This switches the GEQ module between active and bypassed states.
A GEQ module is active when the ON button is lit.

NONE No assignment

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-out 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert out 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-out 1 of STEREO channel L/R or the MONO channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-out 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert out 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-out 2 of STEREO channel L/R or the MONO channel

NONE No assignment

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-in 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert in 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-in 1 of STEREO channel L/R or the MONO channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-in 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert in 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-in 2 of STEREO channel L/R or the MONO channel
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Rack module editor — GEQ window

In this window you can select the insertion destination of GEQ, and edit the parameters.

1Rack No. (Rack selection)
Select the rack module of the GEQ rack that you want to control.

2 LIBRARY
This button accesses the GEQ library. Clicking this button will open the 
GEQ page of the Library window.

● 31BandGEQ

● Flex15GEQ

2

1
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3 Input patch
Click the CHANNEL field, and choose one of the following as the signal route that will be 
patched to the input channel(s) of the currently selected GEQ module.

The channel name is shown in the boxes immediately below.

4 Input meter
This indicates the level of the signal that is being input to the currently selected GEQ mod-
ule.

5Output patch
Click the CHANNEL field, and choose one of the following as the signal route that will be 
patched to the output channel(s) of the currently selected GEQ module.

The channel name is shown in the boxes immediately below.

6Output meter
This indicates the level of the signal that is being output from the currently selected GEQ 
module.

NONE No assignment

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-out 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert out 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C)
Insert-out 1 of STEREO channel L/R or the MONO 
channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-out 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert out 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C)
Insert-out 2 of STEREO channel L/R or the MONO 
channel

NONE No assignment

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-in 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert in 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C)
Insert-in 1 of STEREO channel L/R or the MONO 
channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-in 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert in 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C)
Insert-in 2 of STEREO channel L/R or the MONO 
channel

3 4

65
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7ON (GEQ on/off)
Switches the currently selected GEQ module on/off.

8 LINK
This button links the settings of two adjacent odd-numbered/even-numbered 31BandGEQ modules, or the group A 
and group B settings of a Flex15GEQ. When you click this button, a window will ask you for confirmation. Click the 
buttons for the modules you want to use as the parameter copy-source and copy-destination. If you click the RESET 
BOTH button, the parameters of both modules will be reset to the default state.

9GEQ graph
This graph shows the response of the currently selected GEQ module.

0GEQ faders
These faders cut/boost the frequency bands of the GEQ module. The value of each fader is shown in the numerical box 
below it. Hold down the <Ctrl>(< >) key and click to set the value to 0.00 dB.

A EQ FLAT
This button resets all GEQ faders to the 0 dB position.

BAVAILABLE BANDS (number of operable bands) (Flex15GEQ only)
For a Flex15GEQ, you can operate any fifteen of the thirty-one bands. This numerical display box shows the remaining 
number of bands that can be operated. If you have operated fifteen bands, this number will be zero, and you won’t be 
able to operate any additional bands. If you want to operate another band in this state, you’ll need to return a previ-
ously-operated band back to the 0 dB position.

● 31BandGEQ

7

0

A

8

9

A

8

7

B

0

● Flex15GEQ
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Rack module editor — Automixer window

Here you can edit the parameters of the Automixer.
In situations such as an unscripted speech, the automixer automatically detects the mics that are in use and optimizes their 
gain distribution. This maintains a consistent system gain among multiple mics without requiring an engineer to be 
focused on fader operations.

1RACK No.
Select the rack module of the GEQ rack that you want to control. The 
Automixer can be mounted only in rack number 1.

2Channel indication
For channels 1–8 and channels 9–16, this shows the auto mix gain 
meter and status of each channel: man (yellow) / auto (green) / mute 
(red).
When you select the channel 1–8 or channel 9–16 area, the channels 
shown in the channel control field will switch between 1–8 and 9–16.
(For the 8-channel Automixer, only channels 1–8 are shown.)

1

2
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❏Master field

3OVERRIDE / PRESET / MUTE
This setting can be made for the group (a/b/c) that is selected in the channel control field. Only the selected group is 
shown.

• OVERRIDE
If OVERRIDE is turned on, the setting will switch to man mode or mute mode, depending on the override settings of 
the channels in the same group.

• PRESET
Switches the channels of the same group to the mode (man/auto/mute) that has been preset.

• MUTE
Switches the channels of the same group to mute mode.

4meters
Switches the meter indicator of the channel control field. Each time you press the button, the setting cycles between 
gain, input, and output.

5 reset
Initializes the settings of the automixer.

3 4 5
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❏Channel control field

6 Level indicator
Indicates the automixer level.

Lit green: Audio is at an appropriate level for the automixer
Unlit: Lower than the appropriate level
Lit red: Higher than the appropriate level

Adjust the HA gain of the QL unit so that the indicator remains lit green.

7Meter indicator
Each time you press the 4 meters button in the Master field, you’ll cycle between the fol-
lowing three types of meter.

Normally you should leave this set at automix gain.

8weight
Adjusts the mutual sensitivity between input channels. Adjust the weight setting so that all 
of the automix gain meters are at approximately the same level when there is no input.

9group
Each channel can be assigned to three groups (a/b/c).
The channel’s background color will change depending on the selected group.

0override
When you press the 3 OVERRIDE button in the Master field, the corresponding channels 
will switch to man mode or mute mode depending on the setting of this button.
• If the channel’s override button is on, turning on the master OVERRIDE button will 

switch the channel’s mode to man.
• If the channel’s override is off, turning on the master OVERRIDE button will switch the 

channel’s mode to mute.
• When you turn the master OVERRIDE button off, that channel will return to its prior 

mode.

AChannel number
Indicates the channel number within the automixer.

BChannel name
Indicates the name of the channel that is patched.

Cman / auto / mute
Toggles between man/auto/mute.

man: Passes the audio without changing the gain.
auto: The automixer will be on.
mute: The channel will be muted.

Dpreset
Selects the channel’s mode (man/auto/mute) when the 3 PRESET button in the master 
field has been pressed. The preset indicator will switch between man/auto/mute each time 
you press the preset button.

Meter display color Meter type

Green (gain) Automix gain

Yellow (input) Input level

Blue (output) Output level

6

7

9

A
B

C

8

D

0

NOTE

NOTE
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EFFECT page

1Mount
Select an effect module or GEQ module for mounting in the rack, from the following choices.

2 Input patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be patched to 
the L/R input channels of the internal effect. This is not shown if nothing is mounted in the rack. 

BLANK No assignment

31BandGEQ 31-band 1-in/1-out graphic equalizer

Flex15GEQ 2-in/2-out graphic equalizer that allows any fifteen of the 31 bands to be controlled

EFFECT Internal effect 

NONE No assignment

MIX 1–16 MIX channel 1–16

MATRIX1–8 MATRIX channel 1–8

ST L, ST R, MONO(C) STEREO channel L/R, MONO channel

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-out 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert out 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-out 1 of STEREO channel L/R or the MONO channel

1 2 3 4 56
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3Module graphic
This area shows a graphic of the effect module or the GEQ module that is currently assigned to the rack, and the 
parameters of that module. Double-click this to open the module editor for that rack unit. By holding down the 
<Ctrl>(< >) key of your computer keyboard and double-clicking this, you can open multiple rack module editors. For 
these additional editors, the rack select buttons are not linked with the RACK popup window of the QL itself.

4 Input meter/Output meter
These indicate the level of the signals being input and output from the effect module or the GEQ module.

5Output patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be patched to 
the L/R output channels of the internal effect. 

6BYPASS
This switches the effect module or the GEQ module between active and bypassed states. An effect module is active 
when the BYPASS button is dark.

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-out 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert out 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-out 2 of STEREO channel L/R or the MONO channel

NONE No assignment

CH 1–64 (CH 1–32 on the QL1) INPUT CH 1–64 (CH 1–32 on the QL1)

STIN1L–STIN8R ST IN channel 1–8 (L/R)

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-in 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert in 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-in 1 of STEREO channel L/R or the MONO channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-in 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert in 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-in 2 of STEREO channel L/R or the MONO channel
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Rack module editor — Effect window

Here you can select the effect type for an internal effect, edit the parameters, and specify the input/output patching.
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1Rack No. (Rack selection)
Select the rack module of the EFFECT rack that you want to 
control.

2BYPASS
This button temporarily bypasses the effect.

3CUE
This button cue-monitors the output of the currently selected 
effect.

If the Channel Select/Sends On Fader checkbox 
in the System Setup dialog box is not checked, 
the [CUE] button will be hidden in the screen.

4 EFFECT NAME
Indicates the title of the currently selected effect.

5TYPE (EFFECT TYPE)
Indicates the currently selected effect type. You can also switch the effect type from this window. To do so, click the text 
box, and select the desired effect type from the popup menu that appears.

6 LIBRARY
This button accesses the effect library. Clicking this button will open the EFFECT page of the Library window.

7 Input patch
Click the L CHANNEL or R CHANNEL area, and choose one of the fol-
lowing as the signal route that will be patched to the L/R input channels of 
the internal effect.

The channel name is shown in the boxes immediately below.

NONE No assignment

MIX 1–16 MIX channel 1–16

MATRIX1–8 MATRIX channel 1–8

ST L, ST R, MONO(C) STEREO channel L/R, MONO channel

INS1 CH1–CH64 
(CH 1–32 on the QL1)

Insert-out 1 of INPUT CH1–64 
(1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert out 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C)
Insert-out 1 of STEREO channel L/R or 
the MONO channel

INS2 CH1–CH64 
(CH 1–32 on the QL1)

Insert-out 2 of input channel 1–64 
(1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert out 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C)
Insert-out 2 of STEREO channel L/R or 
the MONO channel

21 3

4 5 6 NOTE

8

0
9

7
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8 Input meter
Indicates the level of the signal being input to the internal effect.

9Output patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be patched to 
the L/R output channels of the internal effect.

The channel name is shown in the boxes immediately below.

0Output meter
Indicates the level of the signal being output from the internal effect.

AParameter display select button
If “REV-X HALL,” “REV-X ROOM,” “REV-X PLATE,” or VCM effect is selected as the effect type, this button switches 
between the standard parameter screen and a dedicated GUI screen.

BMIX BALANCE
Adjusts the balance of the effect sound relative to the original sound. 0 (%) outputs only the 
original sound, and 100 (%) outputs only the effect sound.

CTEMPO
If a tempo-type or modulation-type effect is selected, this allows you to adjust time-related 
parameters such as DELAY (delay time) and FREQ. (modulation speed.)
To set the value of the TEMPO parameter, you can either input the BPM (Beats Per Minute) 
in the numerical box, or repeatedly click the TAP TEMPO button at the desired tempo.
If the MIDI CLK button is on, the TEMPO parameter value will synchronize to the MIDI 
timing clock being received from the MIDI port.

NONE No assignment

CH 1–64 (CH 1–32 on the QL1) INPUT CH 1–64 (CH 1–32 on the QL1)

STIN1L–STIN8R ST IN channel 1–8 (L/R)

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-in 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert in 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-in 1 of STEREO channel L/R or the MONO channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-in 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert in 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-in 2 of STEREO channel L/R or the MONO channel

B

C
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D SOLO
If “M.BAND DYNA” or “M.BAND COMP” are selected as the effect type, these buttons 
allow you to monitor only the specified band from the three bands HIGH, MID, and LOW. 

EGR meter (Gain Reduction meter)
If “M.BAND DYNA” or “M.BAND COMP” are selected as the effect type, this indicates the 
gain reduction amount for the H (HIGH), M (MID), and L (LOW) bands.

FPLAY/REC (Play/Record) buttons
If “FREEZE” is selected as the effect type, you can use these buttons to record and play back the signal being input to 
the effect.

G Effect parameters
This area shows the effect parameters and knobs for the currently selected effect type. It also shows the GUI screen that 
are specific to the following each effect type: REV-X HALL, REV-X ROOM, REV-X PLATE, COMP276, COMP276S, 
COMP260, COMP260S, EQUALIZER601, and OPENDECK.

D

E

F G
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PREMIUM page

1Mount
Select a PREMIUM rack module (EQ or compressor) for mounting in the rack, from the following choices: BLANK, 
Portico5033 (DUAL/STEREO), Portico5034 (DUAL/STEREO), U76 (DUAL/STEREO), Opt-2A (DUAL/STEREO), 
EQ-1A (DUAL/STEREO), and DynamicEQ (DUAL/STEREO.)
U76 (DUAL/STEREO) can be mounted only in an odd-numbered rack, and  occupies two rack spaces.

2 Input patch
Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the stereo EQ or compressor), and choose one 
of the following as the signal route that will be patched to the input channel(s) of the currently selected PREMIUM rack 
module.

NONE No assignment

MIX 1–16 MIX channel 1–16

MATRIX1–8 MATRIX channel 1–8

ST L, ST R, MONO(C) STEREO channel L/R, MONO channel

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-out 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert out 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-out 1 of STEREO channel L/R or the MONO channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-out 2 of input channel 1–64 (1–32 on the QL1)

1 2 3 4 56
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3Module graphic
This area shows a graphic of the PREMIUM rack module that is currently assigned to the rack, and the parameters of 
that module. Double-click this to open the module editor for that rack unit. By holding down the <Ctrl>(< >) key of 
your computer keyboard and double-clicking this, you can open multiple rack module editors. For these additional edi-
tors, the rack select buttons are not linked with the RACK popup window of the QL itself.

4 Input meter/Output meter
This indicates the level of the signal that is being input and output from the currently selected PREMIUM rack module.

5Output patch
Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the stereo EQ or compressor), and choose one 
of the following as the signal route that will be patched to the output channel(s) of the currently selected PREMIUM 
rack module. 

6BYPASS
This switches the PREMIUM rack module between active and bypassed states. A PREMIUM rack module is active 
when the BYPASS button is dark.

INS2 MIX1–MIX16 MIX channel 1–16 insert out 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-out 2 of STEREO channel L/R or the MONO channel

NONE No assignment

CH 1–64 (CH 1–32 on the QL1) INPUT CH 1–64 (CH 1–32 on the QL1)

STIN1L–STIN8R ST IN channel 1–8 (L/R)

INS1 CH1–CH64 (CH 1–32 on the QL1) Insert-in 1 of INPUT CH1–64 (1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert in 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert-in 1 of STEREO channel L/R or the MONO channel

INS2 CH1–CH64 (CH 1–32 on the QL1) Insert-in 2 of input channel 1–64 (1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert in 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert-in 2 of STEREO channel L/R or the MONO channel
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Rack module editor — Premium window

Here you can select the module type (EQ or compressor) for the PREMIUM rack, edit the parameters, and specify the 
input/output patching. Parameter changes can be made in the specific GUI displayed on the right side of the screen for 
each PREMIUM rack module. For information on the parameters of each PREMIUM rack module, please refer to the 
“QL’s Reference Manual”
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1Rack No. (Rack selection)
Select the PREMIUM rack module that you want to control.

2BYPASS
This button temporarily bypasses the PREMIUM rack module.

3CUE
This button cue-monitors the output of the currently selected PREMIUM rack module.

If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is not checked, the 
[CUE] button will be hidden in the screen.

4 EFFECT NAME
Indicates the title of the currently selected PREMIUM rack module.

5TYPE (Module type)
Indicates the currently selected PREMIUM rack module type. 

Selecting the module type is not available in the PREMIUM rack.

6 LIBRARY
This button accesses the Premium rack library. Clicking this button will open the PREMIUM rack module (EQ or com-
pressor) page of the Premium Rack Library window.

21 3

5 64

NOTE

NOTE
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7 Input patch
Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the 
stereo EQ or compressor), and choose one of the following as the signal route 
that will be patched to the input channel(s) of the currently selected PRE-
MIUM rack module.

The channel name is shown in the boxes immediately below.

8 Input meter
Indicates the level of the signal being input to the PREMIUM rack module.
When the stereo EQ or compressor has been selected, display the meter of 
both the L/R.

9Output patch
Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the 
stereo EQ or compressor), and choose one of the following as the signal route 
that will be patched to the output channel(s) of the currently selected PRE-
MUIM module. 

The channel name is shown in the boxes immediately below.

0Output meter
Indicates the level of the signal being output from the PREMIUM rack module.
When the stereo EQ or compressor has been selected, display the meter of 
both the L/R.

NONE No assignment

MIX 1–16 MIX channel 1–16

MATRIX1–8 MATRIX channel 1–8

ST L, ST R, MONO(C) STEREO channel L/R, MONO channel

INS1 CH1–CH64 
(CH 1–32 on the QL1)

Insert-out 1 of INPUT CH1–64 
(1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert out 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C)
Insert-out 1 of STEREO channel L/R or the 
MONO channel

INS2 CH1–CH64 
(CH 1–32 on the QL1)

Insert-out 2 of input channel 1–64 
(1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert out 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C)
Insert-out 2 of STEREO channel L/R or the 
MONO channel

NONE No assignment

CH 1–64 (CH 1–32 on the QL1) INPUT CH 1–64 (CH 1–32 on the QL1)

STIN1L–STIN8R ST IN channel 1–8 (L/R)

INS1 CH1–CH64 
(CH 1–32 on the QL1)

Insert-in 1 of INPUT CH1–64 
(1–32 on the QL1)

INS1 MIX1–MIX16 MIX channel 1–16 insert in 1

INS1 MTRX1–MTRX8 MATRIX channel 1–8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C)
Insert-in 1 of STEREO channel L/R or the 
MONO channel

INS2 CH1–CH64 
(CH 1–32 on the QL1)

Insert-in 2 of input channel 1–64 
(1–32 on the QL1)

INS2 MIX1–MIX16 MIX channel 1–16 insert in 2

INS2 MTRX1–MTRX8 MATRIX channel 1–8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C)
Insert-in 2 of STEREO channel L/R or the 
MONO channel

8

<

7
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This window shows the signal levels of each section in the QL, letting you check for the presence of signals and whether an 
overload is occurring.
This window is divided into INPUT METER and OUTPUT METER; to switch pages, click the tabs located at the top of the 
window. 

In order to view the QL’s signal levels in the Meter window, make sure that QL Editor and the QL itself are 
synchronized. Also, please make sure that the Level Meter is enabled in the System Setup dialog box 
( ➥ p.2.)

INPUT METER page

1METERING POINT
Select one of the following as the point where metering will occur.
PRE G.C, PRE D.GAIN, POST D.GAIN, PRE FADER, POST ON

2PEAK HOLD
Switches peak hold on/off.

3Meters
These peak level meters show the input level of each channel. The current fader value is shown in the box below. 
If clipping occurs at any one of the detection points in the channel, the  segment will light.

Meter window

NOTE

1 2 3
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OUTPUT METER page

1METERING POINT
Select one of the following as the point where metering will occur.
PRE EQ, PRE FADER, POST ON

2PEAK HOLD
This is the same as in the INPUT METER page.

3Meters
This is the same as in the INPUT METER page.

1 2 3
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In this window you can select the channels that will be assigned to each DCA group and mute group. This window is 
divided into three pages; the DCA GROUP ASSIGN page, the MUTE GROUP ASSIGN page and CHANNEL LINK page.

DCA GROUP ASSIGN page

Here you can specify the channels that will be assigned to DCA groups 1–16.

1DCA group
This is the number of the DCA group.

2DCA group name
This is the name of the DCA group. You can also click the mouse on this area to edit the name.

3PRE&POST (DCA MUTE TARGET)
These buttons determine whether a Send signal routed to the bus (that features a send point set to PRE) can be muted. 
Turn this button on to specify PRE and POST as the mute target. Turn this button off to specify only POST as the mute 
target.

4Grid
This grid lets you assign channels (horizontal rows) to DCA groups (vertical columns.) Currently-patched grids are 
indicated by a  symbol. To enable or disable an assignment, click the desired grid.

Group/Link window

1 2 4 53
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5CLEAR
These buttons clear all channels assigned to the corresponding DCA group. When you click one of these buttons a win-
dow will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.

MUTE GROUP ASSIGN page

Here you can specify the channels that will be assigned to mute groups 1–8. The upper part of the screen lets you assign 
input channels to mute groups, and the lower part of the screen lets you assign output channels to mute groups.

1Mute group
This area shows the mute group number.

2Mute group name
This area shows the mute group name. Click this area to edit the name.

3MUTE (MUTE MASTER)
These buttons enable/disable each input channel or output channel mute group. If the mute groups are completely 
muted, they are shown in red. If the dimmer levels for those groups are set in a non-default status, they are shown in 
orange.

4Grid
This grid lets you assign channels (horizontal rows) to mute groups (vertical columns.) Currently-patched grids are 
indicated by a  symbol. To enable or disable an assignment, click the desired grid.

5MUTE SAFE ON
These buttons switch Mute Safe on/off for each channel. Channels for which this button is on will be excluded from 
mute groups.

7

5

1 2 3 64
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6CLEAR
These buttons clear all input channels and output channels assigned to the corresponding mute group. When you click 
one of these buttons a window will appear, asking you to confirm the operation. To execute the Clear operation, click 
the OK button.

7DIMMER LEVEL
These knobs adjust the dimmer level for each group to lower the signal level of the group to the amount of attenuation 
you set. For example, a certain amount of the monitor speaker level for a group of musicians can be lowered temporar-
ily to avoid an excessive monitor speaker level during MC in between songs.

CHANNEL LINK page

If you link two or more input channels, the parameters of these channels will interlock with each other and change simul-
taneously.

2

1

3

5

4
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1 Link buttons
Use these buttons to select the link group A-Z, a-n to which you want each input channel to be assigned. If you don’t 
want an input channel to be linked, select NONE. You can assign up to forty groups for INPUT CH 1–64 (QL1: 1–32 
and ST IN CH 1–8.)

2CLEAR ALL
Clears the link settings for all channels.

3 LINK GROUP button
If you select a link group using one of the corresponding Link buttons (1), the LINK GROUP button will automati-
cally select the same link group.

4 LINK PARAMETER
This section enables you to select the parameters to interlock.

The HA, FADER, DIGITAL GAIN, and DELAY parameters will maintain level differences between linked 
channels.

5 SEND PARAMETER
Specify the link status for each MIX/MATRIX SEND bus.

HA Head amp gain and phantom power settings

HPF HPF settings

DIGITAL GAIN DIGITAL GAIN settings

EQ Equalizer settings

DYNAMICS1 Dynamics 1 settings

DYNAMICS2 Dynamics 2 settings

INSERT INSERT settings

DIRECT OUT DIRECT OUT settings

MIX SEND Send amount from input channel to MIX bus

MIX ON MIX SEND on/off

MATRIX SEND Send amount from input channel to MATRIX bus

MATRIX ON MATRIX SEND on/off

FADER Fader level value

DCA DCA settings

CH ON Input channel module output on/off

MUTE Mute settings

TO ST TO ST settings

DELAY Delay settings

NOTE
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Here you can manage scene memories, and make various settings related to scene recall operations.
This window is divided into SCENE MEMORY, RECALL SAFE, FADE TIME, and FOCUS RECALL pages. To switch 
pages, click the tabs shown in the upper part of the window.

Regardless of the file type of the opened file, executing SAVE or SAVE AS in this window will save only 
the scene library data.

SCENE MEMORY page

Here you can edit the QL’s scene memories. You can also load scene library files from a USB flash drive or from a drive of 
your computer, and edit them. In this case, you can re-save all scenes to a file after editing, recall just a desired scene, or 
copy a desired scene to the scene memory of the QL itself.

1 File name
Indicates the file name of the currently-open scene 
library.

2OPEN (Open a file)
Opens a scene library file located on a drive of 
your computer.

3CLOSE (Close a file)
Closes the currently-open scene library file.

4 SAVE
Saves the currently-open scene library file on a 
drive of your computer.

5 SAVE AS (Save as a different name)
Saves the currently-open scene library file under a 
different name on a drive of your computer.

6 FILE
This area lists the scenes in the file you opened 
using the OPEN button (2). The list includes the 
following items.

To view items that are not currently 
shown, scroll the list to the right.

Scene window

NOTE

1 2 3 4 5

6

HINT
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7No.
This is the scene number in the file you opened.

8TITLE
This is the scene title. You can also double-click this area and edit the title.

9PROTECT
This indicates whether protect is on or off for each scene. This area displays a lock icon for protected scenes; these 
scenes cannot be overwritten, nor their title edited. Read-only scenes are indicated by “R” displayed in this column.

0COMMENT
This column shows the comment assigned to each scene. You can also double-click this column and edit the comment.

A FOCUS
This displays the parameters that will be recalled by scene recall.

• [FOCUS] button
This switches the FOCUS button on/off.

• [SET] button (only for INTERNAL 
DATA list)
Click this to access the Focus Recall Setup screen 
(shown at right), where you can view the Focus 
function settings for each scene.
For an explanation of the contents shown, refer 
to the FOCUS RECALL page. (➥ p.85)

• FOCUS Indicator
Indicates the status of the Focus Recall settings. 
The indicator will lit in black when all parame-
ters are set to off. 
It will lit in green when all parameters are set to 
on and lit in blue when only some parameters 
are set to on. 

BTIME STAMP
Indicates the time at which the scene was last stored, in the format of month/day/year/hours/minutes/seconds. This 
column is only for display, and cannot be edited.

C FADING
This switches FADING on/off for each scene.

D FADE TIME
Indicates the FADE TIME for each scene. You can edit the FADE TIME by double-clicking this field.

RACK GEQ and internal effect settings will be recalled

HA Internal head amp and external head amp settings will be recalled

IN PATCH Input patch settings will be recalled

OUT PATCH Output patch settings will be recalled

IN Input channels (INPUT, ST IN, DCA) settings will be recalled except for head amp settings

OUT Output channel (MIX, MATRIX, STEREO/MONO) settings will be recalled

WITH SEND Send settings to the output channels will be recalled

DCA DCA settings will be recalled

OTHERS Other settings will be recalled

7 8 9 0 BA C D
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E INTERNAL DATA
This area shows the QL’s scene memory contents. The items displayed are the same as in the FILE list (6).
As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy or 
move them to a different location within a list.

F STORE
Stores the current settings to the scene that is selected in the list.

GRECALL
Recalls the settings of the scene selected in the list.

HCLEAR
Clears the scene(s) selected in the list.

IUNDO
Cancels the last-performed scene recall, store, copy, or move operation.

JPROTECT
Turns on the Protect setting for the scene(s) selected in the list.

G
F

H
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RECALL SAFE page

Here you can make settings for the Recall Safe function that excludes only specific channels from recall operations of all 
scenes.

❏ INPUT SAFE PARAMETERS field
In this area you can view and edit the Recall Safe settings for all input channels and ST IN channels. This area contains the 
following items.

1 SAFE ON/OFF
These are on/off buttons that select the channels to be excluded 
from recall operations.

2Parameter matrix grid
Here you can select the parameters to be excluded from recall 
operations. If the ALL button is on, all parameters will be 
excluded.

3 SET ALL
These buttons turn on all buttons for all input channels or ST IN 
channels, or for the corresponding parameter.

4CLEAR ALL
These buttons turn off all buttons for all input channels or ST IN 
channels, or for the corresponding parameter.

❏OUTPUT SAFE PARAMETERS field
In this area you can view and edit the Recall Safe settings for all output channels. The items in this area are the same as in 
the INPUT SAFE PARAMETERS field.

1 2

3
4
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❏GLOBAL RECALL field
In this area you can view and edit the Recall Safe parameters. These are not channel parameters, but QL global parameters 
for such things as patches, DCA groups, and racks.

5 INPUT PATCH
Excludes INPUT PATCH settings from recall operations when the button is on.

6 INPUT NAME
Excludes the channel names of input channels from recall operations when the button is on.

7HA
Excludes Head Amps of I/O rack currently connected to the QL from recall operations when the button is on.

8MUTE NAME
If this button is turned on, the mute group name will be excluded from the recall target.

9OUTPUT PATCH
Excludes OUTPUT PATCH settings from recall operations when the button is on.

0OUTPUT NAME
Excludes the channel names of output channels from recall operations when the button is on.

ACH LINK
Excludes CH LINK settings from recall operations when the button is on.

BCUSTOM FADER
If this button is turned on, the custom fader banks will be excluded from the recall target.

CPORT TO PORT PATCH
If this button is turned on, the PORT TO PORT patch settings will be excluded from the recall target.

DPORT TO PORT HA
If this button is turned on, PORT TO PORT HA settings will be excluded from the recall target.

EDCA
These buttons exclude DCA groups from recall operations. If the ALL button is on, the LEVEL, ON, and DCA group 
names will be excluded. If the LV/ON button is on, LEVEL and ON settings will be excluded.

FGEQ RACK 
Excludes GEQ rack settings from recall operations when the button is on.
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G EFFECT RACK
Excludes EFFECT rack settings from recall operations when the button is on.

HPREMIUM RACK
Excludes PREMIUM rack settings from recall operations when the button is on.

I FADER BANK SELECT
If this button is turned on, the banks that have been selected in the fader block of the QL’s fader bank section will be 
excluded from the recall target.

J SET ALL
This button switches on all buttons for all parameters.

KCLEAR ALL
This button switches off all buttons for all parameters.

FADE TIME page

Here you can make settings for the Fade Time function which adjusts the time over which fader and pan will reach their 
new values when a scene is recalled. Since the Fade function settings are independent for each scene, you must recall the 
desired scene before you make these settings.

2 3
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1 INPUT/ST IN/DCA
These on/off buttons select the input channels that will be excluded from recall operations.

2 SET ALL
This button switches on the buttons of all input channels.

3CLEAR ALL
This button switches off the buttons of all input channels.

4MIX, MATRIX, STEREO/MONO
These are on/off buttons that select the output channels that will be excluded from recall operations.

5 SET ALL
This button switches on the buttons of all output channels.

6CLEAR ALL
This button switches off the buttons of all output channels.

7 FADING ENABLE
This button enables/disables the Fade function for the faders of the current scene.

8 FADE TIME
Drag this knob in the screen to adjust the fade time. The current value is shown in the numerical box immediately 
below.

7 8
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FOCUS RECALL page

Here you can make focus recall settings to specify the channels and parameters that will be recalled for the currently 
selected scene.

❏FOCUS field
1 ENABLE

Enables/disables focus recall.

❏ INPUT FOCUS PARAMETERS field
Here you can view and edit all of the focus recall settings for the 
input channels and ST IN channels. This includes the following 
items.

2 FOCUS ON/OFF
Acts as an on/off button that selects the channels that will be 
recalled by scene recall.

3Parameter matrix grid
Select the parameters that will be recalled by scene recall. If the 
ALL button is on, all parameters will be recalled.

4 SET ALL
Turns on the buttons of all input channels, ST IN channels, or 
the corresponding parameter.

5CLEAR ALL
Turns off the buttons of all input channels, ST IN channels, or 
the corresponding parameter.

2 3
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❏OUTPUT FOCUS PARAMETERS field
Here you can view and edit all of the focus recall settings for the output channels. The included items are the same as for 
the INPUT FOCUS PARAMETERS field.

❏FOCUS PARAMETERS field
Here you can make global focus recall settings for the entire QL console such as for patching, DCA groups, and racks (as 
opposed to focus recall settings for individual channels).

6 INPUT PATCH
If this button is on, input patch settings will be recalled by scene recall.

7 INPUT NAME
If this button is on, the channel names of input channels will be recalled by scene recall.

8HA
If this button is on, the head amps of all detected I/O racks will be recalled by scene recall.

9MUTE NAME
If this button is turned on, the mute group name will be included in the recall target.

0OUTPUT PATCH
If this button is on, output patch settings will be recalled by scene recall.

AOUTPUT NAME
If this button is on, the channel names of output channels will be recalled by scene recall.

BCH LINK
If this button is on, channel link settings will be recalled by scene recall.

CCUSTOM FADER
If this button is turned on, the custom fader banks will be included in the recall target.

DPORT TO PORT PATCH
If this button is on, the PORT TO PORT patch settings will be specified as the recall target.

EPORT TO PORT HA
If this button is on, the PORT TO PORT HA settings will be specified as the recall target.
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FDCA
These buttons specify the DCA groups that will be recalled by scene recall. If the ALL button is on, LEVEL, ON, and 
DCA group names will be recalled by scene recall. If the LV/ON button is on, LEVEL and ON will be recalled by scene 
recall.

GGEQ RACK
If these buttons are on, the corresponding GEQ rack will be recalled by scene recall.

H EFFECT RACK
If these buttons are on, the corresponding EFFECT rack will be recalled by scene recall.

IPREMIUM RACK
If these buttons are on, the corresponding PREMIUM rack will be recalled by scene recall.

J FADER BANK SELECT
If this button is turned on, the banks that have been selected in the fader block of the QL’s fader bank section will be 
specified as the recall target.

K SET ALL
Turns on the buttons of all parameters.

LCLEAR ALL
Turns off the buttons of all parameters.
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In this window you can make settings for the Custom Fader Bank. This window is divided into B1, B2, B3 and B4 pages. 
To open these pages, choose [Custom Fader Bank Setup] from [Windows] menu and click the “B1,” “B2,” “B3” and “B4” 
tabs shown in the upper part of the window. 

1CURRENT USER
Displays the name of the user currently logged into the QL console. If the QL has not yet been synchronized with the 
Editor, this field displays “Administrator.”

2 EDIT
Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the Custom Fader Bank that 
you are editing. “Ext.User” is the user who is currently logged into the QL console via a user authentication key stored 
on a USB flash drive or the QL console. You can select this user only when the QL console is synchronized with the Edi-
tor. 

Ext.User’s Custom Fader Bank settings will not be stored in a file.

3CLEAR ALL
This button clears all settings of a Custom Fader Bank page currently opened.

4 Fader channel
Select the fader channel you wish to assign to the Custom Fader Bank.

Custom Fader Bank Setup window

21
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This window shows the channels of the custom fader bank setup. To open this window, choose [Custom Fader Bank] from 
[Windows] menu and then choose one of the pages.

1Channel Patch
Click here to select the channel that will be assigned to the channel strips, from the following choices.

This patch is color-coded and indicates the type of channel as follows:
Blue: Input channels, Orange: Output channels, White: Other channels.

2Channel Strip
Shows the channel strip that is assigned to the channel patch. This is the same as the channel strip in the Overview win-
dow. Indicates only L or R channel for the ST IN and ST channel. You can switch between L and R by clicking the [SEL] 
button.

CH 1–64 (CH 1–32 on the QL1) INPUT CH 1–64 (CH 1–32 on the QL1)

STIN1L-STIN8R ST IN channel 1–8 (L/R)

MIX 1–16 MIX channel 1–16

MTRX1–8 MATRIX channel 1–8 

ST L, ST R, MONO(C) STEREO channel L/R or MONO(C) channel

DCA 1–16 DCA channel 1–16

MONITOR MONITOR channel

STIN 1–8 ST IN channel 1–8

ST STEREO channel

CUE CUE channel

SEL CH Selected channel

SEND MSTR SEND MASTER (in SENDS ON FADER mode)

Custom Fader Bank window

2

1
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In this window, you can specify the functions or parameters to be assigned to the USER DEFINED keys of the QL. Opera-
tion of each parameter is done by the USER DEFINED keys of the QL.

To open this window, choose [User Defined Keys Setup] from [Windows] menu.

1CURRENT USER
Displays the name of the user currently logged into the QL console. If the QL has not yet been synchronized with the 
Editor, this field displays “Administrator.”

2 EDIT
Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the User Defined keys that you 
are editing. 
“Ext.User” is the user who is currently logged into the QL console via a user authentication key stored on a USB flash 
drive or the QL console. You can select this user only when the QL console is synchronized with the Editor.

Ext.User’s User Defined key settings will not be stored in a file.

3 Function names
Select the functions or parameters you wish to assign to the User Defined keys.
Click a User Defined key to open the Parameter List dialog box.

For more information on the assignable parameters, please refer to the QL’s manual.

User Defined Keys Setup window

2 31
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In this window, you can specify the functions or parameters to be assigned to the USER DEFINED knobs in the screen of 
the QL. Operation of each parameter is done by the USER DEFINED knobs of the QL. 

To open this window, choose [User Defined Knobs Setup] from [Windows] menu.

1CURRENT USER
Displays the name of the user currently logged into the QL console. If the QL has not yet been synchronized with the 
Editor, this field displays “Administrator.”

2 EDIT
Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the User Defined knobs that 
you are editing. 
“Ext.User” is the user who is currently logged into the QL console via a user authentication key stored on a USB flash 
drive or the QL console. You can select this user only when the QL console is synchronized with the Editor.

Ext.User’s User Defined knob settings will not be stored in a file.

User Defined Knobs Setup window

1 23
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3User Defined Knobs
Select the functions or parameters you 
wish to assign to the USER DEFINED 
knobs. Click a User Defined knob to 
open the Parameter List dialog box.
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SENDS ON FADER mode enables you to adjust the send level to the MIX/MATRIX bus using the fader. In this mode, the 
signals sent from all input channels to a specific MIX/MATRIX bus can be adjusted simultaneously.
Use the SENDS ON FADER button in the Sends On Fader window or Master window to switch this mode on and off.

To display this window, do one of the following:
• Select [Sends On Fader] in the [Windows] menu.
• Click the SENDS ON FADER button in the Master window.

In SENDS ON FADER mode, the color and function of the [ON] button and the fader in the Overview window will 
change.

Click the button (in the Sends On Fader window) for the MIX/MATRIX bus for which you want to adjust the send level. 
Then switch the send level off or on, and adjust the send level using the [ON] button and fader for the input channel dis-
played in the Overview window.

For MATRIX bus send, not only the input channels but MIX channels and STEREO/MONO channels can 
be in SENDS ON FADER mode.

[ON] button
Color of the send destination Send is on.

Gray Send is off.

Fader
Color of the send destination The signal is sent to the bus.

Gray The signal is NOT sent to the bus.

Sends On Fader window

NOTE
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In the Outport Setup window you can assign the source channel for each output port and set the parameters. 

The window includes the following items.

1Output port select tabs
These tabs switch the output ports controlled in the window in groups of up to eight ports.

2DELAY SCALE field
Here you can select the units for the delay time shown below the delay time knob (8). If the RECORDER tab is 
selected for the Output port select tabs (1), the DELAY SCALE field will be hidden in the screen.

• meter (343.59m/s)
The delay time is shown as a distance in meters, calculated as the speed of sound (343.59 m/s) at an air temperature 
of 20°C (68°F) multiplied by the delay time (seconds.)

• feet (1127.26ft/s)
The delay time is shown as a distance in feet, calculated as the speed of sound (1127.26 feet/s) at an air temperature 
of 20°C (68°F) multiplied by the delay time (seconds.)

• sample
The delay time is shown as a number of samples. If you change the sampling frequency at which the QL operates, 
the number of samples will change accordingly.

• ms
The delay time is shown in units of milliseconds.

3Output port
This indicates the type and number of the output port to which the channel is assigned.

4Channel select
This area lets you select the channel that is assigned to the output port. 

5Channel name
Indicates the name of the channel that is assigned to the corresponding output port.

6DELAY button
Switches the output port delay on/off.

7Delay time
The millisecond delay time value is shown above the knob.
The delay time value in the units selected in the DELAY SCALE field (2) is shown below the knob.
Click the ▲/▼ buttons to make detailed settings.

Outport Setup window
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8DELAY TIME (Delay time knob)
This knob sets the delay time of the output port. Rotate (by dragging) this knob to set the delay time.

9Ø (Phase) button
Switches the phase of the signal assigned to the output port between normal phase (black) and reverse phase (orange.) 
It is not adjustable if the output-port is set to the RECORDER.

0GAIN knob
Adjusts the gain level for the signal assigned to the output port. To change the value, rotate (by dragging) the knob in 
the screen. You can adjust the setting in 0.1 dB steps over a range of –96 to +0 dB. The current value is shown immedi-
ately below the knob.

A Level meter
This meter indicates the level of the signal assigned to the output port. 
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Menu Action
Key operation

Windows Mac

File menu

Creates a new Session Ctrl+N +N

Opens a previously saved Session Ctrl+O +O

Saves the current Session Ctrl+S +S

Edit menu
Undo Ctrl+Z +Z

Redo Ctrl+Y +Y

Windows menu

Closes the active window Ctrl+W +W

Closes all windows Ctrl+Alt+W +Option+W

Tiles all windows Ctrl+T +T

Cascades all windows Ctrl+Alt+T +Option+T

Opens the Master window Ctrl+1 +1

Opens the Sends On Fader window Ctrl+2 +2

Opens the INPUT CH (CH1-16) window Ctrl+Alt+1 +Option+1

Opens the INPUT CH (CH17-32) window Ctrl+Alt+2 +Option+2

Opens the INPUT CH (CH33-48) window (only QL5) Ctrl+Alt+3 +Option+3

Opens the INPUT CH (CH49-64) window (only QL5) Ctrl+Alt+4 +Option+4

Opens the ST IN window Ctrl+Alt+6 +Option+6

Opens the MIX window Ctrl+Alt+7 +Option+7

Opens the MATRIX window Ctrl+Alt+9 +Option+9

Opens the STEREO/MONO window Ctrl+Alt+0 +Option+0

Opens the Selected Channel window Ctrl+3 +3

Opens the Library window Ctrl+4 +4

Opens the Patch Editor window Ctrl+5 +5

Opens the Virtual Rack window Ctrl+6 +6

Opens the Meter window Ctrl+7 +7

Opens the Group/Link window Ctrl+8 +8

Opens the Scene window Ctrl+9 +9

Synchronization menu Opens the Re-Synchronize window Ctrl+0 +0

Library window or 
SCENE MEMORY page 
of the Scene window

Selects consecutive multiple items (memories) Shift+click shift+click

Selects non-consecutive multiple items (memories) Ctrl+click +click

Selects all memories in a section Ctrl+A +A

Keyboard Shortcuts
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B
BYPASS ..........................62, 64, 68, 70

C
CLEAR ............................47, 75, 76, 80
CLEAR ALL ............ 49, 77, 81, 83–88
CLOSE ........................................ 45, 78
COMMENT ..................................... 79
Ctrl( )+click .....................................8
Ctrl( )+Shift+Click .........................8
Custom Fader Bank Setup window

....................... 88
Custom Fader Bank window ......... 89

D
DCA fader ........................................ 24
DCA group ...................................... 74
DCA window ................................... 24
DIRECT OUTPUT PATCH page .. 51

E
Effect

GR meter .................................... 66
SOLO .......................................... 66

EFFECT module .............................. 63
Effect parameters ............................ 66
EFFECT TYPE ................................ 64
EQ FLAT .......................................... 57

F
Fade ................................................... 84
Fade function (enables/disables) ... 84
FADE TIME page ........................... 83
FILE ............................................ 46, 78
File

Close ..................................... 45, 78
Open ..................................... 45, 78

FOCUS RECALL page ................... 85
FROM MIX, ST/MONO(C) .......... 41

G
GEQ faders ....................................... 57
GEQ graph ....................................... 57
Group/Link window ....................... 74

CHANNEL LINK page ............ 76
DCA GROUP ASSIGN page ... 74
MUTE GROUP ASSIGN page .. 75

I
INPUT CH window ........................ 12
INPUT INSERT PATCH page ...... 50
INPUT PATCH page ..................... 49
INTERNAL DATA ................... 47, 80

K
Keyboard Shortcuts .........................96

L
Library window ................................45

M
Master window ..................................9
MATRIX Bus Setup ...........................3
MATRIX SEND ...............................22
MATRIX window ............................20
Meter window ..................................72
MIX BALANCE ...............................65
MIX Bus Setup ...................................3
MIX/CH/ST IN ................................20
MIX/MATRIX SEND .....................27
MONO ..............................................43
Mute group .......................................75
MUTE MASTER .............................75
MUTE SAFE ON .............................75

O
Offline Edit .........................................8
OPEN ..........................................45, 78
Outport Setup window ...................94
OUTPUT INSERT PATCH page ..51
OUTPUT PATCH page ..................50

P
Patch Editor window .......................49

DIRECT OUTPUT PATCH page
.......................51

INPUT INSERT PATCH page ..50
INPUT PATCH page ................49
OUTPUT INSERT PATCH page

.......................51
OUTPUT PATCH page ...........50
PATCH LIST page ....................52

PATCH LIST page ...........................52
PLAY/REC .......................................66
Premium Rack Library window ....48
PROTECT ..................................79, 80

R
RECALL ......................................47, 80
Recall Safe .........................................81
RECALL SAFE page ........................81
REDO ..................................................6
Re-synchronize ..................................8

S
SAVE ...........................................45, 78
SAVE AS .....................................45, 78

Save as a different name ...........78
Save under a different name ....45

SCENE MEMORY page ................. 78
Scene window .................................. 78

FADE TIME page ..................... 83
FOCUS RECALL page ............. 85
RECALL SAFE page ................. 81
SCENE MEMORY page ........... 78

Selected Channel window .............. 25
Channel selection ....26, 37, 41, 43
COMPANDER .......................... 32
COMPRESSOR, EXPANDER .. 31
DCA GROUP/MUTE GROUP .. 36
DE-ESSER .................................. 33
EQUALIZER ....................... 29, 39
Fader .........................36, 40, 42, 44
FROM MIX, ST/MONO(C) .... 41
GATE/DUCKING .................... 30
HA/D.GAIN/HPF/Ø/GC ........ 27
Input channel ............................ 25
INSERT ...................................... 34
MATRIX channel ..................... 41
MIX channel .............................. 37
MIX/MATRIX SEND ............... 27
RECALL SAFE/MUTE SAFE .. 36
STEREO/MONO channel ....... 43
TO MATRIX ............................. 37
TO STEREO/MONO ......... 28, 38

Sends On Fader window ................ 93
SET ALL ...............................81, 83, 84
Setup

Mixer ............................................ 3
System ........................................... 2

ST IN window .................................. 15
STEREO/MONO window ............. 22
STORE ........................................ 47, 80
Synchronization ................................ 8
Synchronize ....................................... 8

T
Tabs ..................................................... 7
TEMPO ............................................ 65
TIME STAMP ................................. 79

U
UNDO ....................................6, 47, 80
User Defined Keys Setup window .. 90
User Defined Knobs Setup window

....................... 91
USER KEY .......................................... 4

V
Virtual Rack window ...................... 53
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